## Contents

**Quick start** .................................................................................................................. 1

**Welcome to Corel AfterShot Pro** .............................................................................. 9

* Corel AfterShot Pro workspace ............................................................... 14
* Understanding non-destructive editing ................................................... 16
* Understanding the Library ............................................................................. 18
* Supported file formats .................................................................................. 20

**Library and catalogs** .............................................................................................. 21

* Importing images .............................................................................................. 23
* Managing your Library ..................................................................................... 25

**File System mode** ..................................................................................................... 29

* Working in File System mode .......................................................................... 30

**Editing photos** ......................................................................................................... 31

* About adjustment tools ...................................................................................... 32
* Standard tools ..................................................................................................... 35
* Color tools .......................................................................................................... 40
* Tone tools ............................................................................................................ 46
* Detail tools ........................................................................................................... 47
* Metadata tools ...................................................................................................... 51
* Plugins .................................................................................................................. 54
* Selective editing .................................................................................................... 56
* Retouching with Heal and Clone ........................................................................ 64
* Cropping and straightening ................................................................................ 67
* Presets .................................................................................................................... 69
Copy and pasting settings .................................................. 73
Using the History palette .................................................. 73
Editing photos in an external image editor ......................... 74

Organizing, keywords, and metadata .................................. 75
Versions ........................................................................... 76
Stacks .............................................................................. 79
Thumbnail indicators .......................................................... 82
Sorting and filtering ............................................................ 83
Labels, ratings, and flags ...................................................... 85
Working with keywords ...................................................... 87
Working with metadata ....................................................... 91
Finding photos by using metadata ....................................... 94

Outputting images ............................................................. 97
Using Save File As ............................................................ 98
Using batches ................................................................... 99
Managing batches ............................................................. 101
Understanding settings for batches .................................... 103
Web Galleries ................................................................... 110
Using batches to copy files ............................................... 111

Printing ............................................................................ 113
Working with print batches ................................................. 114
Managing print batches ..................................................... 117
Print settings .................................................................... 119
Quick start

This section introduces some of the basic tasks that you can accomplish in Corel® AfterShot™ Pro. If you're looking for a quick way to start working with the application, take a few minutes to go through the steps below. The steps include handy shortcuts and tips that help you work quickly.

There are three main steps:
1. Open your photos in Corel AfterShot Pro.
2. Select and edit one or more photos.
3. Output your edited photos individually or as a batch.

Before you begin, see Corel AfterShot Pro workspace for a quick overview of the workspace.

Step one: Open your photos

To get you started quickly, we're going to work directly from the folders on your computer. After you're familiar with the application, you can choose to build a Library by importing photos into Corel AfterShot Pro. When you're ready for more information, see Understanding the Library.

To navigate to your photos

- In Corel AfterShot Pro, click the File System tab, and navigate to your folder in the Directory View.
  
  When you click a folder, the photos from the folder are displayed as thumbnails in the Thumbnail panel.
Step two: Selecting and editing photos

To view and adjust images, you need to select them. The **Thumbnail panel** displays thumbnails of the photos that are in the active folder. When you select a thumbnail, the **Preview panel** displays a larger view of the photo. When you edit a photo, the original file (master file) is never altered — edit information is saved separately and what you see onscreen is a master version, a preview that shows your edits. You can edit the entire photo or a selected area of the photo. When you are finished editing a photo, you can simply move on to the next photo, or you can save your changes as a new version. This means that you capture the edits as a variation of the original file. The *version* can be viewed as a thumbnail or in the **Preview panel**. It can also be output.

**To preview and select photos**

1. In the **Browse panel**, click the **File System** tab.
2. Navigate to the folder you want. The **Thumbnail panel** displays the photos that are in the folder.
3. Click a thumbnail to display it in the **Preview panel**.
Before you start editing, you can choose between viewing the edits directly on the master version of your file, or creating a new version for editing by pressing **Insert** or by right-clicking the thumbnail and choosing **Version > New Version from Defaults**.

<table>
<thead>
<tr>
<th>You can also</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll quickly through thumbnails</td>
<td>Press [ or ].</td>
</tr>
<tr>
<td>Compare two or more photos (or versions) in the Preview panel</td>
<td>Click the <strong>Toggle Multi-Image View</strong> button (or press M), and <strong>Ctrl</strong> + click or <strong>Command</strong>-click the thumbnails. The <strong>Preview panel</strong> displays the selected photos. You can also select a sequence of photos by using <strong>Shift</strong> + arrow keys. This is a great way to select and flag the best photo in a series of similar photos. For more information about flagging and organizing your photos, see <em>Organizing, keywords, and metadata</em>.</td>
</tr>
<tr>
<td>Select all thumbnails</td>
<td>Press <strong>Ctrl</strong> + A or <strong>Command</strong>-A.</td>
</tr>
<tr>
<td>Deselect thumbnails</td>
<td>Click a background area of the <strong>Thumbnail panel</strong> or press <strong>Ctrl</strong> + D or <strong>Command</strong>-D.</td>
</tr>
</tbody>
</table>

**Note:** The last image you select is called the *active* image. While in **Multi-Image View** mode, metadata changes, adjustments, and other edits apply only to the active image.
To edit a photo

1. In the **Browse panel**, navigate to the folder you want. The **Thumbnail panel** displays the photos that are in the folder.

2. Click a thumbnail to display it in the **Preview panel**.

3. Experiment by trying any of the editing actions in the following table.

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
</table>
| Flag or add keywords (i.e. add metadata) | • Flag — click a thumbnail and on the **Top** toolbar click the **Flag as Pick** button or press . (period key). To mark a photo as a reject, click the **Flag as Reject** button or press , (comma key).
  • Keywords — on the **Tools panel**, click the **Metadata** tab, click inside the **Keywords** box, and type one or more keywords, separated by commas. |
| Crop a photo        | On the **AfterShot Pro toolbar** at the bottom of the **Preview panel**, click the **Crop** tool. In the **Crop** palette, adjust the settings that you want, and in the **Preview panel**, drag the crop area over the area that you want to preserve. Click **Done** in the **Crop** palette. |
| Adjust the color, tone, or sharpness of the entire photo | In the **Tools panel**, click the **Standard** tab, and adjust the settings you want in the **Basic Adjustments** section. |
Edit a selected area only

1. Click the **Open Layer Manager** button in the upper-right corner of the window.
2. In the **Layers** palette, click the **+Adjust** button at the top of the palette. A new editing layer is created.
3. Click a Region tool, such as the **Circle Region** tool, click an area that you want to adjust, and adjust the **Size, Feather**, or other settings at the bottom of the **Layers** palette.
4. In the **Basic Adjustments** section of the **Tools panel**, adjust any of the settings you want — the changes apply to the selected area(s) of the current layer.

**Tip:** There are some handy ways to undo actions. Here are a few you can try:

- To undo one action at a time, press **Ctrl + Z** or **Command-Z**.
- To reset a **Tools panel** slider to its original setting, double-click the slider name.
- To clear all the changes that you've made to a photo, right-click the thumbnail, and choose **Settings > Apply Default Settings** from the context menu.

**To show your edits on a new version**

- In the **Thumbnail panel**, right-click or **Control**-click an edited photo (master version), and from the context menu, choose **Version > New Version from Current**.

**Note:** You can confirm that a photo has been edited by looking for the **Edit icon** in the upper-right corner of the thumbnail.
A new thumbnail appears next to the thumbnail of the master version. By default, versions use the following naming convention: original file name + version number (_v2, _v3, ...).

Three edited versions based on the same master file

You can now return to the master version and edit it in a new way and create another version. To start from the original settings, you can clear the edits made to the master version by right-clicking or Control-clicking the thumbnail, and choosing Settings > Apply Default Settings from the context menu.

Tip: Whether you choose to create a new version before or after editing a master version depends on your workflow. For example, if you know that you want to make several versions from the outset, you can create a version before you start editing, so you can always see how the original master file looks. If you want to quickly fix a photo, you can simply edit the master version—you can create other versions later if you want. The non-destructive nature of editing in Corel AfterShot Pro gives you maximum flexibility.

For more information about editing photos, see Editing photos.
Step three: Outputting photos for sharing and print

After you organize and edit your photos, you can share your work by outputting your photos. Outputting lets you save your photos to a standard file format so that you can share your work on the Web, via email, or use your files in other applications. You can also output your files to print. There are a number of standard output choices, called batches, that let you output quickly, but you can also create a custom batch. For example, you can choose file type, quality, color space, and image size. You can also set a naming convention to rename the files when they are output and you can apply presets. For more information about outputting, see Outputting images.

To get you started quickly, let's use standard batches to save to JPEG and print a couple of 5 x 7 inch photos.

To output to a full-sized JPEG

1. In the Thumbnail panel, select one or more photos that you want to output.
2. Do one of the following:
   - In the Browse panel, click the Output tab, and in the Batch Output section, drag the thumbnails to JPEG Full Size.
   - Press F (shortcut key assigned to JPEG Full Size batch).
3. In the **Select a Destination** dialog box, choose a folder where the files will be saved.

After you select a destination folder, files are saved automatically to that folder for the rest of the session. You can change the destination and access other output settings by double-clicking a batch name in the **Batch Output** or **Printing** section.

**To print to a standard print size**

1. In the **Thumbnail panel**, select two photos that you want to print.

2. In the **Browse panel**, click the **Output** tab, and in the **Printing** section, drag the thumbnails to a batch name, such as **5x7 Qty.2**.

3. Double-click the batch name to preview the print job in the **Print Settings** dialog box.

4. In the **Print Layout** section, enable the **Scale crop** or **Scale reduce** option (matches the photos to the selected print ratio) and preview the results.

5. Choose your printer from the drop-down list in the bottom left corner.

6. Click **Print**.

**Moving on**

Now that you have been introduced to the basics, here are some additional topics that will provide you with more detailed information:

- **Understanding the Library**
- **Managing your Library**
- **Editing photos**
- **Organizing, keywords, and metadata**
- **Outputting images**
Welcome to Corel AfterShot Pro

What is Corel® AfterShot™ Pro?
Corel AfterShot Pro is a fast, flexible workflow application for digital photos, including RAW formats, JPEG, and TIFF. Corel AfterShot Pro is designed to help you organize, optimize, and output your photos. You can work with individual photos or tap into powerful and flexible multi-image processing options that let you adjust and output your photos so you can print them or share them via email or the Web. Corel AfterShot Pro is completely non-destructive; your original image files are always safe. You can use Corel AfterShot Pro on its own, or with your favorite image editing software.

What's in this user guide?
This user guide includes basic information to help you get started quickly. It includes a quick start section as well as some background information that will help you understand how the application works and what you can do with it. This user guide is meant to accompany the full information set that is available in the Help that is accessible from within the application. For a full list of learning resources, from the menu bar choose Help > Learning Center.

How is Corel AfterShot Pro different from other image-editing software?
There are a few things that set Corel AfterShot Pro apart from traditional image-editing software. Let's take a look at these differences.
<table>
<thead>
<tr>
<th>Action</th>
<th>Traditional image-editor</th>
<th>Corel AfterShot Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open files that you want to edit</td>
<td><strong>File &gt; Open File</strong>, open one or more files.</td>
<td>As a workflow application, you tend to work with folders, so click the <strong>File System</strong> tab, and click a folder. You can then right-click to import the folder to the <strong>Library</strong> or click a thumbnail and start editing.</td>
</tr>
<tr>
<td>Edit files</td>
<td>Start editing each open file, when finished, the editing information is saved to the file.</td>
<td>Start editing, creating one or more looks (versions) for each photo. The edits are saved automatically to a sidecar file (XMP) so that your original file is never affected. You can really experiment, even between editing sessions.</td>
</tr>
<tr>
<td>Save the files</td>
<td><strong>File &gt; Save File As</strong>, usually for each file that you want to output, save to the file format you want (such as JPEG). You either overwrite your existing file, or create a new file.</td>
<td>Select as many thumbnails (photos or looks) as you want, and to save out to a standard JPEG, press <strong>F</strong>. Want TIFF? Press <strong>T</strong>. New files are created, your original file is never affected. *Corel AfterShot Pro lets you output multiple files at one time, and offers a range of settings that let you customize your output.</td>
</tr>
</tbody>
</table>
What is photo workflow?

Photo workflow refers to all the activities that occur between the initial image capture and the final photo output. Photographers have very different workflows, depending on the volume of photos they take and what they do with the photos. Your workflow might be as simple as downloading images from your camera's memory card and printing them on a printer that is attached to your computer. A photo workflow might also include any of the following:

- organizational tasks, such as adding keywords and star ratings so you can search and sort your images
- editing and adjusting photos to correct, enhance, or creatively manipulate photos
- backing up and archiving photos
- sharing photos through email or on the Web
- printing photos in-house, through online printing services, service bureaus, or prepress facilities

Corel AfterShot Pro supports a wide range of workflow options and working styles to ensure that you can get the best quality from your photos in the least amount of time.
Photo workflow: 1. Transfer photos from your camera to your computer, 2. Import the photos into Corel AfterShot Pro, 3. Edit your photos, creating one or more versions, 4. Output a version to a JPEG or TIFF file.

Corel AfterShot Pro is organized into three workflow areas: **Asset management**, **Image editing**, and **Output generation**.
Asset management lets you catalog your original digital photos as master files and view, add, browse and search photo metadata. As your photo library grows from hundreds to thousands of photos, maintaining a coherent, organized, searchable library becomes critical. Corel AfterShot Pro provides all the tools needed to catalog your current photographs, and makes it easy to add to your library.

Image editing lets you adjust and correct elements such as exposure, white balance, detail, and distortions. You can get creative with a variety of editing features that you can apply to an entire photo or a selected area. For example, you can use selective editing to select one color area in your photo and apply a color to that area without affecting the rest of the photo.

Output generation lets you share the photos that you have worked on in Corel AfterShot Pro. Your photos can be output in a wide range of formats that you can print, email, or share on the Web. The powerful Batch Conversion feature lets you take advantage of multi-image processing.
Corel AfterShot Pro workspace

The Corel AfterShot Pro workspace includes the following elements:

1. Menu bar

The menu bar is used to access common functions and features. For example, you can import folders, set your preferences, or access the Help.

2. Browse panel

The Browse panel is your main access point for your photos. The panel has tabs for the Library, File System, and Output pages. Some pages are further divided into sections. For example, the Library page consists of a Catalogs section and a Metadata Browser section. The Browse panel can be hidden so that more room is available for viewing your images. Just click the left arrow at the top of the Browse panel tabs to hide or show the panel.
3. Thumbnail panel
At the top of the main Corel AfterShot Pro window, this panel shows thumbnails for the folder, container, search or browse category selected with the Browse panel. All the images in the folder are initially visible in the Thumbnail panel, but you can filter the images to show only the thumbnails that match a specific set of criteria.

4. Thumb Zoom toolbar
This toolbar contains the Thumbnail Size control which lets you adjust the size of the thumbnails in the Thumbnail panel.

5. AfterShot Pro toolbar
This toolbar contains editing tools and viewing options for the Preview panel.

6. Preview panel
The Preview panel lets you view a large version of the photo that is selected in the Thumbnail panel. When Multi-Image View is enabled, the Preview panel displays previews of all the selected thumbnails. You can view image adjustments and zoom into or out of the selected images.

7. Tools panel
Like the Browse panel, the Tools panel has tabs for pages that contain a number of sections. For example, the Standard page displays the Histogram, Basic Adjustments, and Presets sections. Sections can be pinned so they stay visible.
The **Tools panel** can be hidden so that more room is available for viewing your images. Just click the left arrow at the top of the **Tools panel** tabs to hide or show this panel.

**8. Top toolbar**

This toolbar contains a variety of search, metadata, layer, and viewing commands.

There are many ways to adjust and customize the Corel AfterShot Pro workspace. For more information, see *Adjusting the workspace*.

**Understanding non-destructive editing**

Corel AfterShot Pro is a non-destructive image editor, meaning that adjustments you make to your images in Corel AfterShot Pro will never alter the data in the original image. You are free to experiment as much as you want, knowing that you can always revert to the original version. As a non-destructive image editor, the adjustments you create are stored either in a sidecar XMP file, within the Corel AfterShot Pro catalog database, or both. This means that when you're ready to share or export your work, you need to output the versions you want to a standard file format.

When you edit a photo in Corel AfterShot Pro, a new version is created that contains the adjustments you've made. Corel AfterShot Pro allows more than one set of image adjustments to be made on a single photo, allowing you to efficiently make many versions of a single image. Creating a new version does not make a copy of the original master file, but rather just allows you to apply different image adjustments and metadata to the same Master file.
XMP files

Corel AfterShot Pro stores its settings in an XMP file that is slightly different from other popular image editors and photo management applications. We do this to prevent Corel AfterShot Pro from overwriting settings created by other applications and to circumvent limitations inherent in the current XMP standard (such as only being able to export the metadata from one version at a time, or the inability to save different settings for a RAW file and a JPEG that were created in camera as a RAW+JPEG pair).

Corel AfterShot Pro uses a similar, but slightly different filename to store this enhanced XMP data. The XMP filename is created by simply adding ".xmp" to the end of the complete filename of the image file it describes (while many other applications build the XMP filename by first dropping the image file extension (like "jpg", "nef" or "cr2") before adding "xmp"). So a Corel AfterShot Pro XMP file would look like img_0000.jpg.xmp while an XMP from other applications for the same image would simply be img_0000.xmp.

Corel AfterShot Pro lets you create a standard XMP file that other applications will read, but this limits the settings to those officially supported by the XMP standard (one set of metadata per image file).

Shared XMP data

Other applications store image adjustments in sidecar XMP files, and metadata added in other applications can be imported into Corel AfterShot Pro. These include:

- Star ratings
- Color labels
- Flags (called 'Picks' or 'Selects' in other applications)
- Keywords and categories
- IPTC and EXIF data
Likewise, applying any of these settings to images in Corel AfterShot Pro will write this data back to the XMP file for those images. Many applications allow you sync settings from XMP files with the settings they hold in their internal databases. After the sync process is complete, adjustments made in Corel AfterShot Pro appear in those applications as well.

For more information, see *Organizing, keywords, and metadata*.

**Understanding the Library**

Your **Library** is where you store one or more catalogs of photos. It is a key part of the asset management system. It lets you access the master files (original photos) as well as all the versions that you create. You can read photo metadata, and search and browse for photos based on the associated metadata.

Review the information in this section, and when you're ready to start importing, see *Importing images*.

**The Corel AfterShot Pro Library and catalogs**

If you choose to use Corel AfterShot Pro's asset management features, you will start by importing images into a catalog. This catalog is where data and metadata for your photos will be stored. The Library consists of one or more catalogs, which store data such as:

- Links to original master files (path information and file information)
- Metadata for image searching and browsing
- Image adjustment settings, and a complete editing history
- Previews and thumbnails
- Catalog-specific settings
Asset management is optional

Although importing your photos to the Library is recommended, it is not required. You can still view and edit photos and use the RAW file conversion features without adding files to your Library. How? You simply click the File System tab and navigate to the photos in the Directory View.

When would I not want to import photos?

Here are some examples of cases where you may choose not to import photos:

- If you simply want to see what photos are on a memory card or other storage device. For example, if you want to grab a few RAW files from your friend's memory card, you can use the File System tab to find and view the photos. You can then copy only the photos that you want to your computer and import those photos.

- If you already have an asset management application and don't want to replace it. For example, perhaps you have third-party software that copies and builds an image folder structure.

- If you have many photos that you need to import and you simply want to get started quickly.

Features available after importing photos to the Library

After you import your photos to a catalog in your Library, you have full access to the following features:

- **Browsing multiple folders** — select multiple folders and view all the thumbnails in the folders and subfolders in one flat view.

- **Full editing history** — an editing log is maintained for every change that you make to photos and versions over time. If you do not import your photos, the edit log is maintained only for the current session (the log is cleared when you exit the application).
• **Image search** — find images by searching for filename, EXIF, IPTC or other metadata.

• **Metadata browsing** — browse through your catalog using EXIF, IPTC or other metadata.

• **Image stacks** — group versions from one or many master files together into stacks.

• **Offline image browsing** — find and manage images that are stored on offline media like CDs, DVDs or external hard drives.

• **Initial image settings** — Corel AfterShot Pro stores the first set of adjustments found for every image when you import. This lets you quickly revert to these settings at any time. The **Initial Settings** might be the same as the **Default Settings**, or they might be different because they include any edits or adjustments made in Corel AfterShot Pro before importing.

**Supported file formats**

You can read (open and view) or write (save and export) to a wide range of file formats.

RAW files from a wide array of digital cameras are supported as well as JPEG and TIFF files. The table in the Help lists many supported cameras, but for a list that includes the latest cameras, please visit [www.corel.com](http://www.corel.com), and from the **Support** page, click **Get Answers**. Enter the product name and search for **RAW** in the **Knowledgebase**.
Library and catalogs

In this section, you'll learn about

- the Library
- creating catalogs

About the Library

Your Library is where you store one or more catalogs of photos. It is a key part of the asset management system. It lets you access the master files (original photos) as well as all the versions that you create.

A catalog is a collection of photos and their associated image data. In essence, a catalog is a database that can be managed within Corel AfterShot Pro. Catalogs contain master files, thumbnails and preview images, image settings, image adjustments, and catalog-specific preferences.

The Library can be accessed from the Browse panel. The Library page contains the Catalogs section which lists all the folders and photos that you have cataloged by importing. For more information about importing to the Library, see Importing images.
The Library page in the Browse panel contains the Search box, the Catalog section, and the Metadata Browser.

About catalogs

When images are first imported into a Corel AfterShot Pro catalog, the initial settings used for that image are taken from a Corel AfterShot Pro XMP file if one exists. If no Corel AfterShot Pro XMP file is found, metadata settings (keywords, rating, labels, IPTC or XMP tags) are read from standard XMP files, or the image file itself.

Catalog versus XMP

After images have been imported into a Corel AfterShot Pro catalog, changes to any image or metadata settings are stored within the
Corel AfterShot Pro catalog. The changes can be written back to the AfterShot Pro XMP files manually by selecting the thumbnails for the images you want, right-clicking one of the thumbnails, and selecting XMP > Write AfterShot XMP files. Alternately, you may choose to have Corel AfterShot Pro always keep the XMP files up to date. You can do so in the General preferences by enabling the Allow automatic AfterShot .xmp creation for photos in Catalogs check box.

Multiple catalogs

Most people can easily work with one catalog. All photos are imported to the default catalog, and you can easily search and filter to find the photos you want in the catalog. However, if you take photos for different reasons, professional versus personal for example, you can create separate catalogs. Corel AfterShot Pro lets you build, open, and work with many catalogs from your Library simultaneously. This allows you to group, backup, and manage sets of files as catalogs, while preserving the ability to browse, search, and access any image in any open catalog. For more information about creating catalogs, see Managing catalogs.

Importing images

When you import images into Corel AfterShot Pro, they are added to a catalog. You can choose to import an entire folder, a folder and all the subfolders it contains, or you can selectively import one or more files within a folder.

Importing is a process that you control. If you add a new folder or subfolder to your computer, you must import the new folders if you want to add them to your Library. If you have added several subfolders or individual images to an existing folder structure, you can reimport from the root folder to ensure that you catch all the
new items — duplicate catalog entries are not created if you import a photo from the same source location more than once.

**To import a folder**

1. Do one of the following
   - Click **File > Import Photos from Folder**. In the dialog box, navigate to the folder you want and click the **Select Folder** button.
   - In the **Browse panel**, click the **File System** tab, and in the **Directory View**, right-click the folder you want, and choose **Import Folder** from the context menu.

2. In the **Import Photos** dialog box, confirm that the **Source Folder** button displays the name of your folder.

   To include subfolders, enable the **Include images from subfolders** check box.

3. Confirm that the **Import into Catalog** button displays the name of the catalog you want to use. If you want to create a new catalog, click the button.

4. (Optional) Enable the **Apply Import Settings** check box and enter any keywords that you want to apply to all the photos within the folder. You can also apply presets in the same way.

5. Click **Begin Import**.

   **Note:** All the photos in the folder are cataloged. To check your catalog, click the **Library** tab, and navigate to your folders in the **Catalogs** section. Note that the files are not copied when they are cataloged — they are referenced from their original location.
Tip: If you don't want to import all the photos in a folder, you can open the folder, and in the Thumbnail panel, select the thumbnails for the photos that you want to import. Click File > Import Selected Files, and choose the import settings you want in the Import Photos dialog box.

Managing your Library

Your Library consists of catalogs and the files and versions that each catalog contains. You can move, copy, rename, and delete one or more files or versions at a time to get organized. You can also manage your Library by creating more than one catalog, and control which catalogs are accessible by opening or closing catalogs.

For more information about versions, see Versions.
Moving and copying versions

You can move or copy versions to a new location.

**Note:** When you move or copy a version, the master file and all related versions are copied or moved.

To move or copy versions

- Do one of the following:
  - To move a version, drag the thumbnail from the **Thumbnail panel** to the folder of your choice in the **Browse panel**.
  - To copy a version, hold **Ctrl** or **Command** while dragging the thumbnail from the **Thumbnail panel** to the folder of your choice in the **Browse panel**.

Renaming versions

You can choose to rename your versions by using renaming formats if you want to rename several versions at one time with a consistent format.
The **Rename Versions** dialog box has the following controls and features:

- **Format** — choose from a list of existing formats.
- **New Name** — lets you enter a renaming format. For example, if you use `[jobname]` or `[jobseq]` in the **New Name** box, you can enter a job name in the **Job Name**. The sequence `[jobseq]` format remembers the last number used in any previous renaming for this job name, and will continue numbering where it left off.
- **Next [rseq]** — if you include `[rseq]` in the **New Name** box, that text will be replaced with a unique, incrementing sequence number that will start over the next time you rename versions. This control allows you to set the number.
- **Reset [jobseq]** — restart the numbering for the job name sequence selected.
- **Rename all Versions derived from Master Versions** — enable this check box to number the master versions sequentially and any related versions with the same name (adds ",_v1", ",v2" etc to each version). If you do not check this option, each version is given a unique name.

For more information about how to use renaming formats, see *Renaming formats*.

**To rename one or more versions**

1. Select the thumbnails for the versions that you want to rename.
2. Press **F2** or right-click and select **Version > Rename Version**.
3. Edit the **New Name** field, using text or renaming formats like [date]. Or, select an existing renaming format from the **Format** drop-down list.

   The **Preview** updates as you edit the **New Name** field to show you the results of the renaming format.
Deleting versions

You can delete a master version (which represents the original photo, or master file) at any time, but different things happen when you delete a master version versus other types of versions.

Deleting a master version

When you delete a master version, all associated versions are also deleted. The original master files are moved to your computer's Recycle Bin. Review any messages that appear to confirm the action.

Deleting non-master versions

When you delete versions which are not master versions, there is no impact to the original master file — the version thumbnail and associated data is removed from the sidecar XMP file.

Note: When Multi-Image View is enabled, only the single active version is removed, not the entire selection.

To delete a master file or version

- Select the thumbnails of the master versions that you want to delete and do one of the following:
  - Press Delete.
  - Right-click a thumbnail and choose Version > Remove Version.

If you have selected a master version, a message appears to warn you that the original file for the master version will be moved to the Recycle Bin.
File System mode

**File System** mode lets you access and edit uncataloged photos. It is a quick way to access any supported image file on your computer, without needing to import images into a catalog. It's a good way to access photos that you may not keep, but when you don't import photos, you'll miss out on some features that are only possible when working on images in a Corel AfterShot Pro catalog. If you start working with photos in **File System** mode, you have the option of importing the photos to a catalog later.

For more information about **File System** mode, see *Understanding the Library.*

**Image settings in File System mode**

Since the **File System** mode does not maintain a persistent catalog, the image adjustment and metadata settings are written to a Corel AfterShot Pro XMP file after each adjustment. Each time you browse to a new folder, Corel AfterShot Pro will scan the folder, removing any files from Corel AfterShot Pro that have been deleted from your computer, adding any new images found, and refreshing the settings for all existing files with the latest settings found in the XMP files. This ensures that what you see in Corel AfterShot Pro in File System Mode matches exactly what is saved on your computer. This also means that the edit history (as seen in the **History** palette) is reset between each session.

**Note:** If you're editing in **File System** mode and **Library** mode, it can cause issues — edits to photos may not be visible if you edit the same file in both **File System** mode and **Library** mode (the information is written to the file in a different way). Therefore, it is recommended that after you import a file into a Library catalog, you always access the file from the **Library**.
Working in File System mode

In File System mode, finding images in Corel AfterShot Pro is the same as finding images in Windows® Explorer, Mac® Finder® or other file manager applications.

Whether you choose to work from File System mode or Library mode, you can manage your files is the same way. For more information, see the following topics:

- Moving and copying versions
- Renaming versions
- Deleting versions
Editing photos

The image editor in Corel AfterShot Pro is completely non-destructive, so you are free to experiment and edit your images as much as you want, knowing that you can always revert to the original version. All the edits that you make and metadata that you add is stored either in a sidecar XMP file, within a Corel AfterShot Pro catalog, or both.

To view or use your image adjustments in other applications, you need to output the image. For more information about outputting your files, see Outputting images.

The original file is always protected. The master version is based on the original file, but you can create as many versions as you like.

Because your original file is always protected (as a master file), when you edit a photo, your edits are viewable within Corel AfterShot Pro on a representation of the master file called a master version. You
can create as many additional versions as you like. When you create a version, the application does not need to make a copy of the master file, the information is efficiently stored in the XMP file or catalog, so you can create as many versions as you like without taking up much storage space.

**About adjustment tools**

Most editing tools and controls can be found in the **Tools panel**. When you click the **Standard** tab, you can access the **Basic Adjustments** section, which contains the most common adjustment controls. Other tabs, such as **Color**, **Tone**, **Detail**, and **Metadata**, let you access additional tools and more advanced controls and options. For example, the **Basic Adjustments** section includes **Fill Light**. **Fill Light** also appears in the **Exposure** section of the **Tone** page. In the **Exposure** section, there is an additional control, **Range**, that lets you fine-tune the **Fill Light** adjustment. Adjusting **Fill Light** in one place will update the **Fill Light** setting in all sections — these are just different views of the same control.
The image shows the **Basic Adjustments** section of the **Tools panel** and some common controls. The **Tools panel** can be resized, sections can be pinned, and you can choose to hide or show the panel. There are different ways to adjust the controls in the **Tools panel**. You can also reset controls to their original setting and hide or show the results of a setting.

**Why are some tools and controls not available?**

Some tools and controls are not available under the following conditions:

- The file that you are trying to edit is not available (for example, the files are stored on an external drive that is not currently connected to the computer)
- If you have a layer or selection and the tool or control can be applied only to entire images
- The tool is not compatible with the file format. For example, the following tools can be applied only to RAW files:
  - **Highlight Recovery**
  - **Custom White Balance** (Temp and Tint sliders)
  - **White Balance Presets** (Sunny, Cloudy, Incandescent, etc...)
  - **Noise Ninja™** (only **Auto Profile** is available for other file types)

**To resize, pin, or hide the Tools panel**

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>To resize the</td>
<td>Position your pointer along the left edge of the panel, and drag when your</td>
</tr>
<tr>
<td>Tools panel</td>
<td>pointer changes to the resizing arrows.</td>
</tr>
</tbody>
</table>
To adjust a setting

- Do one of the following:
  - Drag the slider
  - Double-click the corresponding number for the setting and type a new value
  - Using a mouse with a wheel, position your pointer over the control name or slider, and roll the mouse wheel to adjust the setting

To reset a slider to its original setting

- Double-click the slider or control name.

To hide or show the results of a setting

- In the **Tools panel**, mark or unmark the check box to the left of the adjustment tool.

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin a section so that it displays regardless of which page is active</td>
<td>Display the section you want, and click the <strong>Pin</strong> icon in the upper-right corner. To unpin the section, click the icon again.</td>
</tr>
<tr>
<td>Hide the <strong>Tools panel</strong></td>
<td>Click the <strong>Toggle Right Panel</strong> button at the top of the panel.</td>
</tr>
</tbody>
</table>
Standard tools

When you click the Standard tab on the Tools panel, you can access some of the most commonly used image editing tools. Grouping these frequently used adjustments together in one place means that you can perform basic edits quickly without switching between tabs. The controls are divided into three sections: Histogram, Basic Adjustments, and Presets.

Histogram

A histogram is a visual representation of the data that makes up your image. The left side represents the darker areas in your image, the right side represents the highlights, and the height of the colored curves shows you how many pixels of a given value are found in your image.

Basic Adjustments

This section holds the most commonly used image adjustment controls. Many photographers will likely find most of the controls they need in this section.

AutoLevel

AutoLevel examines the tonal range of your image and sets the black and white points to be at points such that a fixed percent of the
image will be pure black and pure white. There are two edit boxes in **AutoLevel**: the left box sets the percentage of the image to be set to pure black and the right box sets the percentage to be set to pure white.

**Perfectly Clear®**

*Perfectly Clear®,* powered by Athentech Technologies Inc., is a simple way to quickly optimize your images. *Perfectly Clear* is award-winning technology that automatically optimizes the lighting for each and every pixel while maintaining true color and zero clipping. *Perfectly Clear* also removes abnormal tint and restores faded photos. It also uses medical imaging technology to improve contrast and sharpen.

**White Balance**

For RAW images, you can select among several preset white balance settings, such as *As Shot*, *Click White*, and *Custom Kelvin*.

Different light sources have different characteristics or warmth that affects how your camera captures images. *White Balance* lets you adjust the overall color in the image, ensuring that colors are accurately reproduced in your photos. You can select a *White Balance* preset, such as *Sunny*, *Shady*, *Tungsten*, or *Flash*, or you can use the *Click White* tool (on RAW, JPEG, or TIFF files) to select a neutral colored object in your image (something that should appear as a neutral gray) which will adjust all the colors in your image to make the point that you clicked neutrally colored.

**To set white balance with the Click White tool**

1. In the *White Balance* section of the *Basic Adjustments* page, click the *Enable the Click White tool* button or press *I*. 
2. In the **Preview panel**, experiment by clicking a neutral area of your photo. The ideal place to click is on a neutral grey that is not overexposed (pure white) or underexposed (pure black) on the image you want to adjust. Clicking different spots will result in different corrections.

3. To fine-tune the white balance, adjust this with the **Temp** slider.

**Straighten**

**Straighten** rotates your image to level a horizon or otherwise straighten your image. For more information, see *Straightening*.

**Exposure**

**Exposure** performs an overall exposure correction, either brightening or darkening all portions of your image.

**Highlights**

Recovers detail from apparently overexposed portions of the image.

**Fill Light**

**Fill Light** brightens shadows and the darker portions of the image without overexposing highlights, and with minimal effect on midtones.

**Blacks**

**Blacks** controls the black point in the image. Values lower than zero remove black from the image; values higher than zero darken the image. The **Histogram** section displays the changes in the image.

**Saturation**

**Saturation** adjusts the intensity of the colors in the image. High saturation settings boost colors and provide rich, vivid color. Low saturation settings produce pastel and more muted colors. Setting
Saturation to zero produces a pure monochrome, black-and-white image.

**Vibrance**

Vibrance is a version of saturation that performs a more gentle correction to skin and other image areas that are already richly saturated.

**Hue**

Hue changes the colors in an image, rotating the "color circle" by the amount indicated by the slider. For example, if the Hue slider is set to 60, then 60 is added to the original hues in your image, so greens become cyan, blues become magenta, and reds become yellow.

![Color Circle Diagram]

**Contrast**

Increasing Contrast makes the dark areas in the image darker, and the bright areas brighter.

**Sharpening**

Sharpening an image makes the high detail portions of the image stand out more by making the edge details more pronounced.
Note: Fine detail control tools like **Sharpening** should be applied and evaluated while looking at a 100% Zoom of the image, either in the **Preview panel** or by using the **Magnifier**.

**Noise Ninja™**

Noise Ninja is a state-of-the-art noise reduction system developed by PictureCode Inc. that can be used as a stand-alone product or within Corel AfterShot Pro. Noise Ninja technology achieves an unprecedented balance between noise suppression and detail preservation, providing natural-looking results without artifacts, and is built into Corel AfterShot Pro. The check box enables or disables Noise Ninja noise reduction, and the slider sets the strength of the noise reduction effect.

For more control, use the **Registered Noise Ninja** section.

Note: Fine-detail control tools, like **Noise Ninja**, should be applied and evaluated while looking at a 100% Zoom of the image, either in the main **Preview panel** or by using the **Magnifier**.

**RAW Noise**

**RAW Noise** reduces noise in RAW files only.

**Keywords**

The bottom of the **Basic Adjustments** section includes a **Keywords** area that shows the keywords for all selected versions. When you have multiple versions selected, the following color coding is used:

- red — the keywords apply only to some of the selected versions
- green — the keywords apply only to the active version
- no color — the keywords apply to all selected versions
Presets

Presets are a great way to help speed up your workflow. You can save your favorite adjustments to presets, create keyword presets, or combine a wide range of photo editing in a preset that can be applied with one click.

For more information, see Presets.

Color tools

The Color tab in the Tools panel lets you access tools focused on color control. The controls are organized into five sections: Curves, Color Correction, Color Balance, White Balance, and Color Management.

Curves

The Curves section is an intelligent combination of standard Curves and Levels tools found in many image editing programs.
The **Curves** section includes the following controls:

- **Apply Curves** — enables or disables **Curves**.

- **RGB** drop-down — allows selecting of individual color channels, or the combined RGB mode.

- **Before/After** drop-down — switches the display from showing the histogram before curve adjustments are applied and after adjustments are applied.

- **Left White Arrow** — sets the input 255 (white) point. Dragging this arrow down shifts the histogram left, making the image darker.

- **Bottom White Arrow** — sets the output 255 (white) point. Dragging this arrow to the left brightens your image, but it can clip highlight details.

- **Left Black Arrow** — sets the input 0 (black) point. Dragging this arrow down shifts the histogram to the left, making the image darker.

- **Bottom Black Arrow** — sets the output 0 (black) point. Dragging this arrow to the right deepens the shadows, and can clip shadow detail.

- **Bottom Grey Arrow** — sets the output 128 (gray) point. Dragging this arrow to the right shifts the midtones to higher values, brightening the image; dragging the arrow to the left darkens the image.

- **Click inside the Curve** tool — click inside the curve tool itself to set or adjust the curve. You can set multiple points and drag to fine-tune your tone control.
- **AutoContrast** — click this button to set the output white and black points based on image content. It uses the **AutoLevel** values (highlight and shadow) to perform a one-time adjustment to increase contrast. The main difference between this tool and **AutoLevel** is that the output white and black values can be more easily adjusted than the **AutoLevel** values.

- **Black Point** tool 🖼, **Gray Point** tool 🖼, **White Point** tool 🖼 — click a tool, then click the image in the **Preview panel** to set the black, gray, or white point to the values of the pixel that you click.

- **Reset All** and **Reset Current** — **Reset All** restores the curve values to a flat curve. **Reset Current** resets the current RGB channel only.

**Color Correction**

The **Color Correction** section of the **Color** page in the **Tools panel** lets you adjust your image selectively based on colors that you sample from your image or colors that you set in the **Color Picker**. The colors you select are stored in color wells. The first six color wells (top row) are preset to the primary and secondary colors. The second set of color wells (bottom row) can be set to any color you choose.
To pick a color as the starting point for a color correction

1. In the **Tools panel**, click the **Color** tab, and open the **Color Correction** section.

2. Click any adjustable **Color Well** that isn't assigned a color (white wells in the second row).

3. Click the **Color Picker** that appears next to the **Hue** slider and click anywhere within your photo to select a color that will be used for color adjustment.

   After your starting color is selected, you can adjust the **Hue**, **Saturation**, or **Luminance** of that color within your image.

4. Adjust **Range** to control the color tolerance. A small range adjusts only colors very close to your selected color; a higher range adjusts a larger color range in your image.

*In this example, Selective Color was used to sample the dress. The Hue was adjusted to change the color of the dress.*
Tip: You can also assign a new color to a color well by clicking the color well that displays to the left of the Color Picker. This opens a color selector window where you can pick a color as your adjustment color.

Color Balance

This section in the Tools panel lets you precisely balance the colors in your image. You can use the following controls:

- **Cyan/Red, Magenta/Green** and **Yellow/Blue** — shifts the color along the color axis.
- **Saturation** — adjusts the intensity of the colors in the image. High saturation settings boost colors and provide rich, vivid color. Low saturation settings produce pastel and more muted colors.
- **Vibrance** — applies a gentle version of Saturation that avoids the oversaturation of skin colors and image areas that are already richly saturated.
- **Hue** — changes the colors in an image, rotating the color wheel by the amount indicated on the slider. For example, if the Hue slider is set to 60, this value is added to the original hues in your image, so greens become cyan, blues become magenta, and reds become yellow.
- **HSL/HSV** — choose between correcting images in HSL (Hue / Saturation / Luminance) and HSV (Hue / Saturation / Value) color spaces.

**White Balance**

*White Balance* provides several preset white balance settings, such as **As Shot**, **Click White**, and **Custom Kelvin**.

Different light sources have different characteristics or warmth that effects how objects appear to you camera. *White Balance* lets you adjust the overall color in the image, ensuring that colors are accurately reproduced in your photos. You can select a *White Balance* preset, such as **Sunny**, **Shady**, **Tungsten**, or **Flash**, or you can use **Click White** to select a neutral colored object in your image (something that should appear as a neutral gray) which adjusts all the colors in your image to make the point that you clicked neutrally colored.

**To set white balance with the Click White tool**

1. In the *White Balance* section of the *Basic Adjustments* page, click the **Enable the Click-White tool** button or press I.
2. In the *Preview panel*, experiment by clicking a neutral area of your photo. The ideal place to click is on a neutral grey that is not overexposed (pure white) or underexposed (pure black) on the image you want to adjust. Clicking different spots will result in different corrections.
3. To fine-tune the white balance, adjust the **Temp** slider.
Color Management

This tool controls the color management mode applied to the active version.

- **Color Mgmt** — enables color management when set to an ICC profile. Switching this to **None-Linear** still applies color management, but leaves the image in a linear color space.
- **Custom Input Profile** — advanced users can choose to create an input profile from the linear data associated with a camera profile.

For more information, see *About color management* in the Help.

Tone tools

The **Tone** tab on the **Tools panel** lets you access controls that let you fine-tune image tone. All the tools are organized in the **Exposure** section.

Exposure

The **Exposure** section combines all the tonal adjustments into a single area. Many of the same controls can be accessed by clicking the **Standard** tab. For more information see *Basic Adjustments* or see *Tone tools* in the Help.
Detail tools

The **Detail** tab on the **Tools panel** lets you access controls that let you sharpen, blur, adjust noise, apply lens corrections or distortions, and add effects, such as vignette or color inversion. The controls are organized into six sections: **Sharpening, RAW Noise, Noise Ninja Standard, Noise Ninja Registered, Lens Correction, and Mirror and Invert.**

**Sharpening**

The **Sharpening** section lets you adjust how sharp or how soft the details are in your image. **Amount** adjusts the overall sharpness, while **Sensitivity** limits what portions of your image are sharpened.
A high **Sensitivity** value results in less of your image being sharpened. If sharpening your image makes noise or highly detailed areas too distracting or too sharp, then try raising the **Sensitivity** value.

**Note:** Fine-detailed control tools, like **Sharpening**, should be applied and evaluated while looking at the image at the 100% zoom level, either in the **Preview panel** or with the Magnifier.

**RAW Noise**

**RAW Noise** is an image improvement process that you can use very early in the image editing workflow to provide the highest quality final images. The feature can be applied only to RAW files.

- **Raw Impulse Noise Removal** — enables the automatic detection and removal of impulse noise (single black, white, or colored pixels).
- **Raw Noise** — reduces noise. You can control the strength of the noise reduction.
- **Threshold** — sets the level of sensitivity for noise detection in the image.

**Note:** Applying **RAW Noise** enables **RAW Impulse Noise Removal**, but you can apply **RAW Impulse Noise Removal** without enabling **RAW Noise**.

**Noise Ninja**

Noise Ninja is a state-of-the-art noise reduction system developed by PictureCode, Inc. **Noise Ninja Standard** is included in Corel AfterShot Pro. To use the **Noise Ninja Registered** section, you must purchase a Noise Ninja license and register with PictureCode. Noise Ninja technology achieves an unprecedented balance between noise...
suppression and detail preservation, providing natural-looking results without artifacts. In the Noise Ninja Standard section, the check box enables or disables Noise Ninja noise reduction, and the slider sets the strength of the noise reduction effect. For more information about Noise Ninja, visit the PictureCode website at http://www.picturecode.com.

Noise Ninja Registered includes the following controls:

- **Enable** — toggles Noise Ninja on or off.
- **Coarse Noise** — removes low-frequency noise in the Chroma channel.
- **Auto Profile** — creates a noise profile for this image instead of using the default profiles. The profiles provided with Corel AfterShot Pro are built using controlled conditions and usually provide results superior to the Auto Profile results.
- **Turbo Mode** — increases the speed of noise reduction. Enabling this option can degrade the quality of the noise reduction.

The lower section of the tool has separate Strength, Contrast, and Smooth controls for Luma noise and Chroma noise. Luma noise is seen as bright or dark speckles in an image, while chroma noise is seen as colored speckles. The following controls are included for both Luma and Chroma:

- **Strength** — controls the overall level of noise reduction applied to the image.
- **Contrast** — adjusts the noise detection procedure by controlling a scaling factor to edges.
• **Smooth** — increases or decreases the noise levels estimated by the noise profile. Usually the default setting is adequate, but if you see isolated specks in smooth areas, try increasing the smoothness setting.

All noise reduction technology causes at least a slight drop in sharpness; the **Noise Ninja Registered** tool contains its own sharpening tool on the **USM** tab to apply an unsharp mask sharpening procedure after applying noise reduction. The **USM** tab lets you access the following controls:

• **Amount** — controls the strength of the sharpening.

• **Radius** — adjusts how much of the image will be affected by the **USM** control.

The last tab, **Profile**, shows what profile is being used in the noise reduction process and tools to create custom noise profiles.

**Lens Correction**

**Lens correction** fixes lens distortion. While zoom lenses with a large range of focal lengths show the greatest lens distortion, even fixed-focal length, or "prime" lenses, can cause some types of distortion. The following types of lens distortion can quickly and easily be corrected in Corel AfterShot Pro: Barrel and Pin Cushion distortion, Chromatic Aberration, and Vignetting. For more information, see **Lens Correction** in the Help.
Mirror and Invert

This simple tool allows you to:

- **Mirror** your image (from left to right).

- **Invert** the colors (like a film negative). This option can be useful when working with scanned negatives.

Metadata tools

The **Metadata** tab contains tools that let you view and edit the metadata associated with your images. This metadata includes camera data, EXIF and IPTC data, as well as information that you add
to your files, such as keywords, star ratings, and captions. The controls are organized into three sections: Metadata, Keywords, and Keyword Sets.

Metadata

This tool shows EXIF and IPTC metadata assigned to the Active Version, and allows you to add, remove or edit the IPTC data from all selected images.

You can select different metadata sets from the drop-down list at the top of the Metadata section, which changes the type of metadata that is shown. Some metadata is read-only, like Shutter Speed and ISO Rating, while other metadata is editable, like Caption, Rating, and Date.

Keywords

This section shows all keywords assigned to the active version and all selected versions. You can add and remove keywords from all selected images.
**Note:** Adding or removing keywords from the **Keywords** section affects all selected images, while the keywords displayed in the section reflect only the active version.

**Keyword Sets**

This section provides a fast and easy way to assign multiple keywords to your photos. You can group similar keywords together in a set and show that set in the **Keyword Sets** section.

For more information about **Metadata** tools, see the following topics:

- *Working with metadata*
- *Working with keywords*
- *Finding photos by using metadata*
Plugins

The Plugin tab lets you access plugins, including plugins developed by third-party developers. These unique image adjustment tools are designed to work directly within Corel AfterShot Pro. The plugins are totally non-destructive, like all of Corel AfterShot Pro's built-in image adjustment tools, and are compatible with Corel AfterShot Pro's selective editing tools.

As you install other plugins, additional tools appear on the Plugins tab. Additional tabs are created automatically as you install more plugins.

For more information about plugins available for Corel AfterShot Pro, visit www.corel.com.

Installing and updating plugins

Plugins are distributed as Corel AfterShot Pro .bzplug files — a single file that contains all the files and information necessary for the plugin to run. A single plugin bundle can be installed on Windows®, Mac, or Linux® (if the developers have built the plugin for all three versions).

To install a plugin

- Do one of the following:
  - Double-click a Corel AfterShot Pro plugin bundle (which ends with the .bzplug file extension).
  - Drag and drop a .bzplug bundle into the Browse panel.
  - Click File > Install Plugin and choose the .bzplug bundle that you want to install.
**Note:** Corel AfterShot Pro checks to make sure the plugin you are trying to install supports your version of Corel AfterShot Pro and your computer type. In some cases, an updated version of the plugin will be installed. You must restart Corel AfterShot Pro to complete the installation process. You can restart immediately after installing or updating a plugin, or you can restart later.

### Corel AfterShot Pro Black & White Plugin

Corel AfterShot Pro includes the **Black & White Plugin** which lets you choose from a variety of color mixing options and use an innovative spot color tool that restores one or two colors to your black and white image.

This plugin includes the following controls:

- **Enable Black & White** — turns the effect on or off.
- **Channel Mixer** drop-down list — lets you choose from several color mixes used to determine the black and white value.
- **First Spot Color** and **Second Spot Color** tabs — sets the spot color restoration options.
- **Enable** — turns the spot color effect on or off.
- **Hue** — specifies the hue to be restored. You can also click the **Color Well** to choose a color.
- **Fuzziness** — sets the range for the restoration based on how close the colors are to the selected hue.

**Selective editing**

**Selective Editing** lets you isolate adjustments or edits to a specified area of a photo. For example, you can select and lighten an area that you want to highlight in a photo, or select an area that you want to edit by using **Heal** or **Clone**. For more information about **Heal** and **Clone**, see [*Retouching with Heal and Clone*](#).

**Selective Editing** has three main steps:
1. Create a layer — See [*To create an adjustment layer*](#).
2. Select one or more areas to edit by creating regions — See [*To create a region*](#).
3. Apply adjustments — See [*To adjust a layer*](#).

Review the information below to learn about layers, regions, and adjustments that can be used with selective editing.

**Layers**

Layers are collections of regions and adjustments. A layer can contain a single region and adjustment, or it can contain many regions and adjustments. All regions in a single layer will have the same adjustments applied. For example, if you want to brighten several faces in a photo, you can create circle regions over each face, and then adjust the **Fill Light** setting for the layer, thereby brightening the shadows for all the selected faces at one time. You can apply other adjustments to the layer as well, but at the point
where you don't want the adjustments to apply to all the selected regions, or you want to adjust a new region, you must create a new layer and select one or more regions that you want to adjust.

The upper area of the **Layers** palette contains the main commands for creating and managing layers, including the Region tools. You can add, delete, duplicate, invert, and rename layers. You can also copy and paste layers — the selected areas and layer settings are copied.

The **Name** list on the **Layers** palette shows all the layers associated with the current version of the photo. You can choose a layer to view the selected regions in the **Preview panel**. You can also choose which layers and regions to show or hide.
The lower area of the **Layers** palette is context-sensitive. It displays settings that you can use to control and fine-tune the active tool.

**Regions**

Regions are selected areas of a photo that you create by using one of the **Region** tools:

- **Circle Region** tool - creates a circular region.

- **Polygon Region** tool - creates a polygon region (triangle, square, rectangle...). The enclosed shape is determined by clicking the image to set points which are connected by straight lines.

- **Curve Region** tool - creates an irregular curvy shape. The enclosed shape is determined by clicking the image to set points which are connected by curved lines.

- **Brush Region** tool - creates a freehand shape. Brushstrokes determine the selected region. You can create the entire region with a brush, or use a brush to add to a region. For example, you can use the **Polygon Region** tool to select a large area of a background and then use the **Brush Region** tool to add small brushstrokes around the borders of the background to ensure that you have complete coverage.

Regions have two areas: the main area and the feather area. The main area is the portion within the solid lines of a region, and this is where the full effect of editing applies. Along the edge of the main area is the feather area. This is the transition area where the selected area blends with the background — from 100% at the inside edge, to 0% at the outer edge of the dashed line.
To have a smooth, gentle fade between a region and the rest of the image, use a large feather size. To make sharp, crisp regions that affect only the selected area inside a region, use a very small feather size.

Regions can also be inverted, so that the edits applied to the layer containing a region will apply to the portion of the image that is outside the selected area.

**Adjusting regions**

After you have created a layer with one or more regions that you want to edit, you can use controls in the **Tools panel** to apply adjustments.

Some adjustments and editing tools are designed to work on the entire image and cannot be applied to a layer. The following adjustments and tools affect the entire image:

- Image Rotation
- Straightening
- Lens Distortion Correction
- Color Management
- AutoLevels
- All Metadata settings (keywords, ratings, labels, IPTC data, etc)
To create an adjustment layer

1. In the upper-right corner of the application window, click the **Open Layer Manager** button.

2. In the **Layers** palette, click the **Add Layer** button. A new layer appears in the **Name** list, below **Main Layer**.

To set layer opacity

- In the **Layers** palette, click a layer name, and adjust the **Opacity** slider at the bottom of the palette.

To rename a layer

- In the **Layers** palette, double-click a layer name in the **Name** list, and type a name.

  **Tip:** You can name your layer according to the type of adjustment you want to make. Later, if you want to make the same adjustment to another region, it will be easy to choose the existing layer and add a region.

To duplicate a layer

- In the **Layers** palette, click the layer that you want to duplicate and click the **Duplicate** button.

To hide or show a layer or region

- In the **Layers** palette, click the box to the left of a layer or region name in **Name** list.

  A check mark appears in the box when the layer or region is visible. The box is empty when the layer or region is hidden.
To delete a layer or region

1. In the **Layers** palette, click the name of the layer or region that you want to delete.

2. Click the **Delete** button at the top of the **Layers** palette.

To create a region

1. In the **Layers** palette, create or select a layer to which you want to add a region.

2. Click one of the following Region tools and follow the instructions in the table.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circle Region</td>
<td>In the <strong>Preview panel</strong>, click the image to set the position of the circle. At the bottom of the <strong>Layers</strong> palette, adjust the <strong>Size</strong> and <strong>Feather</strong> settings.</td>
</tr>
<tr>
<td>Polygon Region</td>
<td>In the <strong>Preview panel</strong>, click the image to set each point of your shape (the points are connected by straight lines). Double-click to complete the polygon. At the bottom of the <strong>Layers</strong> palette, adjust the <strong>Feather</strong> settings.</td>
</tr>
<tr>
<td>Curve Region</td>
<td>In the <strong>Preview panel</strong>, click the image to set each point of your shape (the points are connected by curved lines). Double-click to complete the shape. At the bottom of the <strong>Layers</strong> palette, adjust the <strong>Feather</strong> settings.</td>
</tr>
<tr>
<td>Tool</td>
<td>Instructions</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Brush Region</td>
<td>In the <strong>Layers</strong> palette, enable the <strong>Show Strokes</strong> check box. Adjust the <strong>Size</strong> and <strong>Intensity</strong> settings for your brush, and drag in the <strong>Preview panel</strong> to apply your brushstrokes. When you are finished, you can disable the <strong>Show Strokes</strong> check box. To fine-tune your brushstrokes, toggle between the <strong>Erase Brush</strong> and <strong>Normal Brush</strong> mode. If you want to change the color of your brushstrokes, click the <strong>Color</strong> well and select a color.</td>
</tr>
</tbody>
</table>

**To invert a layer**

- In the **Layers** palette, click a layer name in the **Name** list and click the **Invert** button.

  The outline for the main area of a region changes from black to white when you invert.

**To adjust a layer**

- In the **Layers** palette, click a layer name in the **Name** list, and in the **Tools panel**, adjust the settings you want.

  For information about which adjustments can be applied, see *Adjusting regions*.

**Editing regions**

Editing regions is just as easy as creating regions. You can edit a region by adding, deleting, or moving points on polygon and curved shapes. You can also move a region, adjust the size, or adjust the feathering.
To add a point to a polygon or curved region
1. In the Layers palette, click a region name in the Name list.
2. Hold down the Shift key down and in the Preview panel, position your pointer over the region outline where you want to add a point.
3. When a red circle appears at the correct position, click to add a point.

To delete a point from a polygon or curved region
1. In the Layers palette, click a region name in the Name list.
2. Hold down the Alt key down (or Alt+Shift on some Linux systems) and in the Preview panel, position your pointer over the point that you want to remove.
3. When a red circle appears on the point, click to delete the point.

To move a point on a polygon or curved region
1. In the Layers palette, click a region name in the Name list.
2. In the Preview panel, position your pointer over the point that you want to move.
3. When a red circle appears on the point, drag the point to a new location.

To move a region
1. In the Layers palette, click a region name in the Name list.
2. In the Preview panel, position your pointer over the region.
3. Drag the region to a new location.
To resize a region

- In the Preview panel, position your pointer over a region and roll your mouse wheel to make it larger or smaller.

Blending layers

Blending allows you to "cut out" sections of a region by creating new regions below the initial region and setting Blending to Subtractive. This will subtract the lower regions from any areas where they overlap with higher regions. A Subtractive region that does not overlap with Additive regions above it will have no effect. You can check layer order by looking at the Name list in the Layers palette.

To use a Subtractive layer when blending layers

1. In the Layers palette, click the name of the layer that you want to change to Subtractive or create a new layer.
2. Choose a Region tool, and from the Blending drop-down list, choose Subtractive.
3. Create a region that protects lower regions from the Additive layers above it.

Retouching with Heal and Clone

The Heal and Clone tools let you remove small, distracting elements from your photos. They use layers and Region tools in a similar way to selective editing.

- Healing is best used for small blemishes in smooth, low detail areas, such as a small blemish on skin, or a small bird in the sky. It is limited only to circular regions created with the Circle tool, and unlike cloning, it does not require that you to set a source.
• **Cloning** is the process of copying a part of an image in order to cover up a distracting or unwanted feature in the picture. Cloning takes image content from a source region and places it in the selected area.

Each version can have only one Heal/Clone layer. Copying and pasting a Heal/Clone layer replaces any existing Heal/Clone layer.

**Switch between Heal and Clone**

You can use the Circle tool in Heal or Clone mode. To switch between these modes, simply choose Heal or Clone the Mode drop-down list in the Layers palette. The control is visible only when you create a Circle region.

**To remove a spot with Heal**

1. Click the Open Layer Manager button.
2. In the Layers palette, click the +Heal/Clone button.
3. Click the Circle Region tool, and in the Preview panel, click the spot that you want to remove.
4. In the lower-left corner of the Layers palette, choose Heal from the Mode drop-down menu.

   If you want to adjust the size of the circle or how the edges of the circle blend, drag the Size or Feather sliders at the bottom of the Layers palette.
The Heal mode was used to remove a small white spot from a flower

To cover or copy image areas by cloning

1. In the Layers palette, choose an existing Heal/Clone layer or click the +Heal/Clone button to create a Heal/Clone layer.

2. Click a Region tool.

3. Select the portion of your image that you want to clone out. This is the destination area for the cloning. If you used the Circle tool, make sure the Mode is set to Clone. For information about using regions tools, see To create a region.

4. After you finish creating your destination region, a source region is automatically created (outlined in red). Click and drag the source region to position it over the image content that you want to copy.

Tip: When cloning, you can click the Swap Source button at the bottom of the Layers palette to swap the source region with the destination region. This is useful when you want to duplicate content in an image instead of using cloning to remove image content.
Cropping and straightening
You can improve the composition of your images by cropping or straightening images in Corel AfterShot Pro.

Cropping
Cropping lets you recompose your photo, remove unwanted edge areas, or change the aspect ratio to match a print output. For information about preferences related to cropping, see Crop preferences.

![Cropping palette](image)

To crop a photo
1. Click the **Crop** tool on the **AfterShot Pro** toolbar or press C.
2. In the **Cropping** palette, do one of the following:
   - Choose a preset from the crop preset drop-down menu.
   - Choose **Aspect** or **Pixels** from the **Crop mode** drop-down menu, and type values in the **Height** and **Width** boxes.
3. Drag the edges of the cropping grid that appears in the **Preview panel** to adjust the crop area.
4. Click inside the cropping grid to reposition the crop area.
5. In the **Cropping** palette, click **Done**.
### You can also

<table>
<thead>
<tr>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically maximize the crop region to the edges of the photo</td>
<td>Click the <strong>Fit</strong> button.</td>
</tr>
<tr>
<td>Display or hide the cropping grid</td>
<td>Click the <strong>Enable Crop</strong> check box.</td>
</tr>
<tr>
<td>Switch the orientation of the cropping grid</td>
<td>Click the <strong>Switch height and width</strong> button.</td>
</tr>
<tr>
<td>Lock the aspect ratio of the cropping grid</td>
<td>Click the <strong>Lock</strong> button.</td>
</tr>
<tr>
<td>Add a crop preset to the preset drop-down list</td>
<td>In the <strong>Cropping</strong> palette, enter the <strong>Aspect</strong> or <strong>Pixel</strong> values you want, and click the <strong>Add</strong> button.</td>
</tr>
</tbody>
</table>

**Tip:** You can use the scroll wheel on a mouse to resize the cropping grid.

### Straightening

Straightening lets you correct tilted horizons or apply a creative tilt to your photos.

### To straighten a photo

1. Select the **Straighten** tool from the **AfterShot Pro** toolbar or press **S**.
2. Drag in the **Preview panel** to draw a horizontal or vertical line that you want to use as a reference for straightening the photo.
3. Release the mouse button to apply the changes.
The Straighten tool lets you choose a reference point (emphasized above by a red line) for straightening.

Note: When you straighten a photo, the photo is not cropped automatically, so you will see white areas along the edges of the photo.

Presets

Using presets is a great way to speed up your workflow. You can save your favorite adjustments to presets, create keyword presets, or combine a range of photo editing in a preset that can be applied with one click.

Presets are saved as XMP files in the Corel AfterShot Pro user folder on your computer:

C [a main drive]:\Users\[User name]\AppData\Local\Corel\AfterShot Pro\Presets

This makes it easy to copy presets from one computer to another, or to share presets with others.
Applying and managing presets

Applying a preset essentially applies all the commands and information to the selected files. All the actions appear in the History palette, making it easy to remove any settings that cause an undesired effect.

Many presets can be applied to an image, and each subsequent preset replaces the settings of previous presets with the settings contained in the last preset.

Corel AfterShot Pro includes quite a few presets, but you are encouraged to create your own presets.

To apply a preset

1. In the Thumbnail panel, select the image or images that you want to edit.

2. In the Tools panel, click the Standard tab.

3. In the Presets section, click a preset in the list. Presets are applied to all selected images, except when in Multi-Image View mode.

To create a preset

1. Edit an image, using all the commands and settings that you want to save to the preset.
2. In the **Tools panel**, click the **Standard** tab.

3. In the **Presets** section, click the **Add Preset** button 

4. In the **Save Presets** dialog box, pick a name for the settings, and choose which settings you want to save.

3. Click **OK** to save the preset. The preset name appears in the preset list immediately.

---

**Managing presets**

You can manage your presets. When you open the **Manage** mode, you can create preset folders and move, rename, delete, and view preset settings. Corel AfterShot Pro includes several default presets, all of which are found in the **Default Presets** folder. You can create as many additional folders as you need to categorize and organize your photos. You can also choose which presets display in the **My Favorites** list (the drop-down list on the **Presets** section title bar).

---

**To access the Manage mode for presets**

1. In the **Tools panel**, click the **Standard** tab, and open the **Presets** section.

2. Click the **Manage** button in the lower right corner of the section.
To add or remove a preset to the My Favorites list

- In the Show in Menu column, mark a check box to display the corresponding preset in the My Favorites drop-down list; unmark the check box to remove the preset from the list.

To create folders for presets

1. In the Presets Manage mode, click the Add Folder button .
2. Double-click the new folder that appears at the bottom of the preset list and type a name for the folder.

To move presets

- In the Presets Manage mode, drag a preset from one folder to another folder.

To rename presets or preset folders

- In the Manage mode, double-click a preset or folder in the list, and type a new name.

To delete presets or preset folders

- In the Manage mode, click the preset or folder that you want to delete, and click the Delete button or press Delete on your keyboard.

  Tip: You can undelete a preset by clicking Edit > Undo or by pressing Ctrl + Z.

To view the settings for a preset

- In the Manage mode, click the preset and click the View preset settings button .
Copying and pasting settings
You can copy some or all the settings from one photo and paste the settings to other photos. For example, you can adjust the exposure, color, noise, and sharpness of a photo and apply metadata and keywords. After the photo is perfect, you can copy the settings and paste them to as many similar photos as you want. This is a great way to edit and optimize many images very quickly. For more information, see Copying and pasting settings in the Help.

Using the History palette
Corel AfterShot Pro keeps a list of all the edits and adjustments you make to every image in your catalogs. At any time, you can open the History palette to see what changes have been made to the active version.

If you are working in File System mode, then the History palette contains only the edits from the current session — previous edits are not retained.

To open the History palette
• From the View menu, click History.
To review edits with the History palette

- In the History palette, click an editing action in the list. The photo will temporarily display the state of the photo up to the selected editing action — hiding all the edits you've performed between the action you selected and the most recent edit.

To return to the last edit step, simply click the last step in the list.

Editing photos in an external image editor

You can edit photos in another image editor. At any point, you can open an image editor from within Corel AfterShot Pro. You can set the external editor to use in the Preferences. For more information, see External Editor preferences.

To open a photo in the external image editor

- In the Thumbnail panel, right-click or Control-click a thumbnail, and choose Edit with [external editor].

  Tip: You can also access the external editor from the menu bar, Edit > Edit with [external editor].
Organizing, keywords, and metadata

This chapter describes the metadata features in Corel AfterShot Pro.

Photo metadata, or information about your pictures, can make searching and finding your images much faster and easier. Metadata simply refers to the information about your images, including data recorded by your camera, such as the time, date, exposure, shutter speed, and aperture. You can also add your own metadata to photos to record what the subject is, where you took the photos, and professional photographers can include client information.

Types of metadata

Some metadata is standardized so it can be accessed by a wide range of devices and software. EXIF and IPTC are the most common metadata standards:

- **EXIF (Exchangeable Image File Format):** Data typically recorded by the camera about the settings used for a photo. Most EXIF metadata is not editable. The EXIF data from the original photo (master file) is used for all versions that are derived from the master file (same source). Some examples of EXIF metadata are shutter speed, aperture, ISO, date, and time.

- **IPTC (International Press Telecommunications Council):** Data added by the photographer such as image description, photographer information, copyright, and caption.
Corel AfterShot Pro also supports other metadata, some of which can be shared between different applications. This metadata includes:

- Keywords
- Ratings
- Color Labels
- Flags

Corel AfterShot Pro stores its settings in an XMP file that is slightly different than other popular image editors. For more information, see XMP files.

**Versions**

Versions are used in Corel AfterShot Pro to represent your master files and any variations derived from your master files. When you make edits and image adjustments in Corel AfterShot Pro, you are creating and editing versions, not the original master file. This means you can make as many different versions from a single master file as you like, without ever affecting the original image.

Versions created from the same master file share the same content and are shown in a stack — a set of thumbnails that can be grouped together so that only the top thumbnail shows in the Thumbnail panel. All settings and options can be different, allowing you to make different interpretations, crops or other image adjustments to each version. Versions maintain their own edit history, and can each be assigned unique metadata. The settings for all versions from a single master file are stored inside a single Corel AfterShot Pro XMP file.
Many operations are possible with versions, and many of these are available on the context menu, found by right-clicking on a thumbnail and selecting the Version menu option.

Creating versions

Corel AfterShot Pro automatically creates a master version for each master file in the folder you are viewing. There are several ways to create another version of a photo.
In the example above, the thumbnail on the left is the master version. To the right are two additional versions that have been edited. The number 3 appears on the upper left corner of the master version thumbnail to indicate the total number of versions.

To create a version

- In the Thumbnail panel, right-click an existing version, click Version in the context menu, and choose one of the following options:
  - **New Version from Current** — creates a new version with the same settings as the selected version's current settings
  - **New Version from Master** — creates a new version with the same settings as the master version's current settings.
  - **New Version from Import** — creates a new version with the same settings that the selected version had when it was imported.
  - **New Version from Defaults** — creates a new version with the default image settings for this type of image. For more information, see Default Settings.

  **Note:** When Multi-Image View is enabled, only the active version is the source for the new version.

What happens when a version is deleted?

Deleting a version removes the settings and adjustments made to that version, and removes that version from Corel AfterShot Pro. If the version you are deleting is a master version, then the master file
is moved to the **Recycle Bin**. For more information about deleting versions, see *Deleting versions*.

**Stacks**

Stacks are a visual means of grouping similar images together. Stacks are either **Open** — with all images in the stack visible, or **Closed** — with only the topmost image in the stack exposed. Stacks are groupings of versions, and each stack is contained in one catalog.

At the top is a closed stack. You can open and close stacks by clicking the icon in the upper-left corner of the master version.

**Using stacks**

In **File System** mode, stacks are used only to group multiple versions from one master file.

In the **Library**, stacks can serve many purposes and you can use them for a variety of organizational tasks. For example, you can use stacks to group shots from a burst of images (continuous shooting) or made from exposure bracketing. You can select the best shot from
the group to display as the top image. You can also stack a set of images that you will use to build a multi-image panorama or that you will otherwise combine into a single image in another application. Or, you can use stacks to group similar images together so it's easier to browse through your images.

When you create a new version from an existing version, the versions are placed in the same stack. You can remove these versions from the stack if you want.

**To create a stack**

1. Select the versions that you want to stack.
2. Right-click and choose **Stacking > Stack** or from the menu bar, click **Edit > Stacking > Stack**.

   **Note:** You can make new stacks only when viewing a single folder and not when viewing catalog folders recursively.

**To add versions to a stack**

1. Select the versions you want to add to a stack.
2. Do one of the following:
   - Drag and drop that version onto a stack.
   - Right-click a stack and select **Stacking > Stack**.
   - From the menu bar, select **Edit > Stacking > Stack**.
To remove versions from a stack
1. Select the versions that you want to remove from the stack.
2. Do one of the following:
   - Drag and drop the version outside the stack.
   - Right-click and select Stacking > Unstack.
   - From the menu bar, select Edit > Stacking > Unstack.

To merge two or more stacks
1. Select the versions in the stacks that you want to merge.
2. Right-click and select Stacking > Stack.

Sorting stacks
When sorting the thumbnails in the Thumbnail panel, versions within stacks are not sorted. This is to maintain the manual sort order that you can specify for a stack and ensures the top version stays on top.

The entire stack is sorted in the Thumbnail panel in the location specified by the top image.

You can change the sorting order within a stack by dragging-and-dropping the versions, or by using the commands in the context menu.

Editing images in a closed stack
When editing the top image in a closed stack, only the top version is modified. This includes changes to metadata and ratings.
Thumbnail indicators

The Thumbnail panel and the thumbnails themselves show a great deal of information about your images and the metadata applied to them. Consider the following example:

The first three images are all versions of the same master file, and as such are shown in a stack, as indicated by the outline, and the 3 indicator at the top left corner of the top image in the stack. The table below explains the thumbnail indicators:

<table>
<thead>
<tr>
<th>Thumbnail</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Duplicate" /></td>
<td>Indicates the image is a duplicate version.</td>
</tr>
<tr>
<td><img src="image" alt="Offline" /></td>
<td>Indicates that Corel AfterShot Pro cannot find the master file associated with this image, and is thus &quot;offline&quot;. You can view a preview of the image, if one exists, and can still edit metadata, but you cannot make other types of edits.</td>
</tr>
<tr>
<td><img src="image" alt="Pick" /></td>
<td>Indicates the version has Flag as Pick applied</td>
</tr>
<tr>
<td><img src="image" alt="Reject" /></td>
<td>Indicates the version has Flag as Reject applied&quot;</td>
</tr>
</tbody>
</table>
### Sorting and filtering

#### Sorting

You can sort thumbnails by a wide range of attributes. For a list of sortable attributes, see *Sorting* in the Help.

#### Custom sort order

Besides the sort orders based on metadata (like name or rating), you can also specify a manual sort order to put your images in any order you want.

Custom sorting is only possible when:
- viewing a single folder (not recursive)
- filtering is disabled

**To apply a custom sort order to your images**

1. Select a single folder, disable filtering, and turn off recursive folder browsing.
2. Then, switch the Select Sorting to Custom.
3. Drag the thumbnails into the order you want.

 Filtering
Filtering thumbnails temporarily removes them from the Thumbnail panel, allowing you to focus on a smaller set of images. You can use simple filtering rules, like "Rating–More than or equals–3 stars" or you can use more complex filtering.

![Filter Dialog](image_url)

To filter images
1. Ensure that the images you want to filter are displayed in the Thumbnail panel.
2. On the AfterShot Pro toolbar, click the Show Filter Tool button.
3. Modify any of the following settings:
   - **Rating, Label, and Flag** check boxes enable or disable the filtering for those items, while the drop-down menus and buttons on the right let you select the conditions and what to show.
   - **Always show selected versions** — lets you add the filter results to the currently selected images. If you unmark this check box, only the filter results display in the Thumbnail panel.
• **Require all of the conditions above** — requires that all **Rating**, **Label**, and **Flag** conditions match in order for those images to appear in the **Thumbnail panel**. This is equivalent to an AND search. If this option is unchecked, then versions meeting ANY of the conditions show in the **Thumbnail panel**.

**Note:** Filtering remains on until you unmark the **Rating**, **Label**, and **Flag** check boxes.

**Labels, ratings, and flags**

Color labels, star ratings, and flags are the quickest way to help you find what you’re looking for more quickly.

![Color labels, star ratings, and flags](image)

**Color labels**

Color labels let you categorize your images visually. There are five colors and the unlabeled state. Color labels are often used to categorize images by purpose or edit status. For example, you can assign a red label to images that need post-processing or heavy retouching. You can assign a blue label to images that are part of a panorama or another series.
To assign a color label
1. In the Thumbnail panel, select the images that you want to label.
2. On the Top toolbar, click the Label drop-down menu and choose a color.

   The color labels appear in the lower-right corner of the thumbnails.

   **Tip:** You can also assign a color label to a thumbnail by positioning your pointer over the bottom right corner of a thumbnail and clicking the color label icon to display and choose a color.

Star ratings
Star ratings are a great way to help you to find your best images quickly. You can assign ratings to images in your catalog to quickly select or filter images.

To assign star ratings
1. In the Thumbnail panel, select the images that you want to rate.
2. Do one of the following:
   - Click one of the stars 🌟 on the Top toolbar.
   - Press Ctrl + [1,2,3,4, or 5].

Flags
You can use flags to pick (Flag as Pick) or reject (Flag as Reject) images. You can also clear flags that you assign (Clear Flag).
Flagging is a great way to quickly assess images. You can also use flags to mark images that you are in the process of editing or you can flag several images with similar content so you can quickly select
and compare them when trying to select the best version.

**To flag images**

1. In the **Thumbnail panel**, select the images that you want to flag.
2. Do one of the following:
   - Click the **Flag as Pick** or **Flag as Reject** buttons on the **Top** toolbar.
   - Press . (period key) to pick or press , (comma key) to reject images.

   If you want to clear a flag, click the **Clear Flag** button.

**Working with keywords**

Keywords are words that you associate with your image files. They are used to help you and others search through many images to find what you are looking for. You can use standard keywords or custom keywords. For example, you can add keywords to identify image content, client or job, or the location where images were taken.

There are two ways to assign keywords in Corel AfterShot Pro: type keywords in the **Keywords** section or assign keywords that you've added to the **Keyword Manager** and then apply them by choosing them in the **Keyword Sets** section. You can delete keywords from your images and delete keywords or keyword sets from the **Keyword Manager** at any time. You can also assign shortcut keys to your keywords and keyword sets.
The Keyword Manager helps you organize your keywords

To assign a keyword by typing it in the Keywords section
1. In the Thumbnail panel, select the images to which you want to add keywords.
2. In the Tools panel, click the Metadata tab.
3. In the **Keywords** section, type the keywords that you want to assign. Use the following syntax:
   - Use commas (,) to separate keywords (for example: Mom, Paris, vacation)
   - Use semi-colons (;) to create keyword subcategories (hierarchy) (for example: Travel; France; Paris)

4. Press **Enter**.

**To assign a keyword by choosing it from a keyword set**

1. In the **Thumbnail panel**, select the images to which you want to add keywords.
2. In the **Tools panel**, click the **Metadata** tab.
3. In the **Keyword Sets** section, choose a keyword set from the drop-down menu in the title bar.

4. Click a keyword in the main area of the **Keywords Sets** section to apply it to the selected images.

**To create a keyword set**

1. In the **Tools panel**, click the **Metadata** tab.
2. In the **Keyword Sets** section, click the **Manage** button.
3. In the left pane of the **Keyword Manager**, do one of the following:
• Find existing keywords that you want to add to your set.
• Add keywords as a subcategory of an existing hierarchy. For example, to add the names of family members, you could click Subject > People > Family, and click the Add Child Keyword button. Type a name to add it as a subcategory of Family.
• Create a new hierarchy by clicking the Add Keyword button and typing a keyword. To create subcategories, select a keyword and click the Add Child Keyword button.

4. When you know that you have all the keywords for your set, click the Add Set button below the right pane and type a name for your keyword set. You can type any name, it does not need to match any existing keywords.

5. From the keyword list in the left pane, drag the keywords to the set name in the right pane. The keywords that you drag are what you will see in the set list, regardless of their place in the hierarchy (does not affect hierarchy in any way).

6. Click the Close button at the top of the Keyword Manager window. Your set now appears in the Keyword Sets drop-down menu.

**To remove a keyword from an image**

1. In the Tools panel, click the Metadata tab.
2. In the Thumbnail panel, select an image.
3. In the Keywords section, select the keywords that you want to remove and press Delete.

**Note:** When you delete a keyword, look at any remaining hierarchy references to see if you need to delete the entire hierarchy associated with the keyword.
To delete a keyword or keyword set from the Keyword Manager

1. In the **Keyword Sets** section, click the **Manage** button.
2. In the **Keyword Manager**, do one of the following:
   - Click a keyword in the left pane and click the **Delete Keyword** button.
   - Click a keyword set name in the right pane and click the **Remove Set** button.

To assign a shortcut to a keyword or keyword set

1. In the **Keyword Sets** section, click the **Manage** button.
2. In the **Shortcut** column, double-click the cell that aligns with the keyword or keyword set you want.
   An entry box appears
3. On your keyboard, press the key or key combination that you want to use as a shortcut.
   If the shortcut has already been assigned, a message appears and lets you accept or cancel the keyword change.
4. Click the **Accept** icon to apply the shortcut.

   **Tip:** You can remove a shortcut from a keyword or keyword set by clicking the **Remove** icon.

**Working with metadata**

Corel AfterShot Pro includes all the tools to you need to add, edit and view IPTC 4 XMP metadata as well as EXIF and other metadata.
Much of this metadata is also available in the **Browse panel** so you can quickly find any image shot at a specific location, annotated by a specific person, or otherwise labeled with metadata.

![Metadata example](image)

Corel AfterShot Pro divides the metadata into several groups to make it easier to view and work with the metadata. You can create as many additional groups of metadata as you like so you can display or edit the information more easily.

**Viewing metadata**

Select the **Metadata** tab from the **Tools panel**, then choose which metadata group you want to view from the drop-down list at the top of the **Metadata** section.

**Editing metadata**

All of the metadata fields shown in the **Metadata** section are editable by clicking to the right of the heading that you want to edit. Some metadata is read-only, such as EXIF information related to shutter speed and aperture.

Editing metadata affects only the active version.
Managing metadata sets

Creating and editing metadata sets lets you view and edit the metadata you want quickly. Click the Manage button in the lower-right corner of the Metadata section to open the Metadata Manager. The left column lists all metadata entries available in Corel AfterShot Pro. The right column lists metadata sets and their current content.

The Metadata Set Manager allows you to pick what metadata is shown in each metadata set, and to create new sets.

To add a new metadata set

- Click the Add a new Set button. A new set with the default name "New Set" is created at the end of the Metadata Sets list.
To remove a metadata set

- Select the set you want to remove and click the **Remove Set** button.

To add metadata to a metadata set

- Select the metadata entry in the left column, and drag it to the metadata set in the right column.

Finding photos by using metadata

Assigning metadata to your images makes them much easier to find when you use the **Search** or the **Metadata Browser**. Both features only find images that have been imported into the **Library**. The catalogs must be open in the **Library** to use these features.

Searching for images

If you know exactly what keywords you are looking for, you can search your catalog for that content. Simply type the term you want to search for into the **Search** box at the top of the **Catalogs** section in the **Browse panel**, and press **Enter** to perform the search. The results are shown in the **Thumbnail panel**.

Browsing for images

You can use the **Metadata Browser** section to quickly find images shot on a specific date, with a particular camera, or any combination of the most common shooting information that is captured in the metadata fields or keywords. The number in parentheses beside the
metadata category name indicates how many versions meet the criteria. The **Metadata Browser** is more precise than **Search**.

![Metadata Browser](image)

**Link to catalogs**

The contents and counts in the **Metadata Browser** are determined by the status of the **Link to Catalogs** check box at the top of the **Metadata Browser**:  

- **unchecked** — the **Metadata Browser** shows contents and counts for all catalogs currently open in your **Library**.

- **checked** — the **Metadata Browser** shows only contents and counts for versions in the catalogs and folders that are selected in the **Catalogs** section. This can provide a very concise view of the metadata for the images in one or more folders.

With this control, you can filter out the metadata for portions of your **Library**. For example, if you have your **Library** organized by clients, you can select a specific client's folder in the **Library**. Then, by enabling **Link to Folders**, you can show only the keywords, cameras, dates, and other metadata for images shot for that client.
Refine

You can use Refine to limit what is shown in the Metadata Browser. Refining works by selecting an entry in the Metadata Browser, then clicking the Refine button to limit the search results that match the entry.

You can add entries as you refine in any order you want. For example, you can select three, four, and five stars from the Ratings metadata entry, then click Refine. The results show only your best images — the images that you have tagged with three or more stars. Then, you can select a year or month entry from the Date/Time area, and click Refine again to display your best images from a specific time frame. To remove an entry when refining, click the X button next to the entry.

The items you refine are highlighted in the Metadata Browser to remind you that only a portion of your Library is listed in the counts and contents of the Metadata Browser.
Outputting images

Because Corel AfterShot Pro is non-destructive, the adjustments made to images within Corel AfterShot Pro must be written out to a new image file before these adjustments can be seen in any other application. The process of creating output images is quick, while at the same time powerful and very configurable.

There are two main ways to output photos:

- **Save File As** — you can use the **Save File As** command to output one or more selected photos (versions). This method does not use predefined batch settings, so each time you output, you choose the settings that you want.

- **Batch** — like a preset, a batch uses a set of predefined output settings to output one or more photos (versions). You can configure batches with your favorite settings so you can process many images very quickly without having to choose a folder, image format, rename format, and other settings each time you output. This is often easier and faster to use than **Save**, even when you are outputting a single file.

Output types

There are three types of output that you can choose from: **File**, **Copy**, and **Gallery**.

- **File** output is the most commonly used output type. For example, if you simply want to output your RAW file as a JPEG file, this is the file type to use. This output type creates a new image file in the format that you select. You can apply adjustments and resize the image. You can save to a predefined folder or specify new file names and folders by using renaming formats.
• **Copy** output (batch only) is ideal for transferring images from a memory card to a specific location on your computer and importing files to your Library, all in one step. This output type copies source files (master file and sidecar file) to the folder of your choice. You can also automatically import the files after they are copied so that your catalogs and Library is up-to-date.

• **Gallery** output (batch only) creates image and HTML files that let you create a Web gallery for your photos. Just upload all the files to your website.

### Using Save File As

You can use the **Save File As** command to output one or more photos (versions) without using a batch (a set of predefined output settings). You still go through the **Batch Output Settings** dialog box, so don't worry, you're in the right place. The dialog box displays the settings applicable to the **Save File As** workflow only.

#### To output by using Save File As

1. In the **Thumbnail panel**, select one or more photos that you want to output.

2. On the menu bar, click **File > Save File As** or press **Ctrl + S**

3. In the **Batch Output Settings** dialog box, choose **JPEG** or **TIFF** from the **Image type** drop-down menu.

4. (Optional) Specify any other settings you want. For more information about the settings in the **Batch Output Settings** dialog box, see **Outputting images**

5. For JPEG files, you can type a value in the **Quality** box.

6. Select the file type (TIFF, JPG, etc) that you want to save to, any options associated with that file type, and any other options that you want to apply to the exported file.
7. Click **OK** when you're ready, and all selected files will be written to the folder you've chosen, with the settings you selected.

**Using batches**

You can output one or more photos (versions) to standard file formats by using a batch. Batches save you time by letting you output with your favorite settings by simply clicking a batch name. For example, Corel AfterShot Pro includes the following batches: **16-bit TIFF**, **8-bit TIFF**, **Download**, **Gallery**, **JPEG Full Size**, and **JPEG Proof**.

**What can I do with Download?**

Download is a unique type of batch that lets you copy images from a camera memory card to your computer. You can also copy to a new folder structure and rename files.

**To output by using a batch**

1. Select one or more thumbnails in the **Thumbnail panel**.

2. Do one of the following:
   - Click the **Output** tab, and in the **Batch Output** section, drag the thumbnails over a batch name.
   - In the **Batch Output** section, press the shortcut key associated with a batch.

The shortcut key for each batch is shown to the right of each batch name in the **Batch Output** section. For example, press **F** to send the selected versions to the **JPEG Full Size** batch.
Using batches with folders

You can output an entire folder of images by using a batch.

To output a folder of images by using a batch

1. In the Browse panel, click the Library tab or the File System tab, and navigate to a folder.

2. Right-click the folder and choose Send to batch (include subfolders), and choose a batch name.

   If the Select a destination dialog box appears, navigate to a folder, and click Select Folder.
Pause/Resume

Pausing a batch temporarily stops the processing of the batch. It will stop after the current versions finish processing.

You can toggle the pause state of any batch by simply clicking the Pause button on the progress bar next to the batch you'd like to pause. Corel AfterShot Pro processes several images at a time, so pausing will not stop the images that are currently in progress, so a couple more images will complete before the batch is fully paused.

To pause and resume batch processing

- In the lower-left corner of the application window, click the Pause button. Click the button again to resume processing.

Stop a batch

Stopping a batch halts the process of converting files. Corel AfterShot Pro processes several images at a time, so the batch stops when it completes the versions that it is working on.

To stop a batch

- In the lower-left corner of the application window, click the Stop button to the right of the Pause button.

Managing batches

Corel AfterShot Pro comes with several pre-defined batches that perform many common operations. You can edit or adjust these any way you want and you can create your own batches that perform custom operations that match your workflow.
section, you will click the **Output tab** on the **Browse panel**.

Many operations on batches, like those listed below, can be accessed from the context menu that is available when you right-click in the **Batch Output** list.

You can create a new batch or duplicate a batch. Sometimes it is easier to duplicate an existing batch, and make modifications to this new copy, instead of making a new batch from scratch. You can also rename an existing batch.

You can also assign a shortcut key to a batch. Assigning a shortcut key to a batch lets you add the currently selected versions to that batch by simply pressing the shortcut key associated with that batch. For example, by default the **F** key is assigned to the **JPEG Full Size** batch, so at any time in Corel AfterShot Pro, you can simply press **F** to add the currently selected images to the **JPEG Full Size** batch and output JPEG files.

**To create a batch**

1. Click the **Output** tab.
2. Right-click a blank area of the **Batch Output** section, and choose **New** from the context menu.
3. In the **Batch Output Settings** dialog box, type a name in the **Batch Name** box.
4. Choose the settings that you want to use for the batch.

**To duplicate a batch**

1. Click the **Output** tab.
2. Right-click a name in the **Batch Output** section, and choose **Duplicate** from the context menu.
To delete a batch
1. Click the Output tab.
2. Right-click a name in the Batch Output section, and choose Delete from the context menu.

To rename a batch
1. Click the Output tab.
2. Right-click a name in the Batch Output section, choose Rename, and type a new name for the batch.

Tip: You can also double-click (slowly) a batch name in the Batch Output section, type a new name, and press Enter when finished.

To assign a shortcut key to a batch
1. Click the Output tab.
2. Right-click a batch name in the Batch Output section, and choose Set shortcut from the context menu.
3. Press the key or key combination that you want to use for a shortcut. The shortcut appears in the Set shortcut dialog box.

Understanding settings for batches
When you output your files as a batch, you can specify settings for the batch. The settings available depend on the type of batch. For example, if you choose to output a JPEG Full Size batch, the settings are very different from the settings you choose for a Gallery batch.
By having multiple tabs in the **Batch Output Settings** dialog box, you can create multiple output types within a single batch. For example, you can create small thumbnail images, large Web-viewable images, and full size TIFF images with a single click.

The **Batch Output Settings** dialog box contains the following settings categories: **Image Type**, **Output Name and Location**, **Image Sizing**, **Additional Image Settings**, **Metadata**, and **Post Processing**. For more detailed information, see the descriptions in the topics below.
Batch Name

Batches in Corel AfterShot Pro share some controls:

- **Batch Name** — identifies the batch that you are using. This is also an entry field when you create a new batch.
- **Output** — lets you add more than one output when you run a batch. You can choose from three output types: **File**, **Copy**, **Gallery**. A tab appears for each output type.

Destination

**Destination** determines where the files will be saved. You can choose from the following options:

- **Ask** — prompts you for a location (**Select a Destination** dialog box) each time you output. If you want to set it once for the entire session, enable the **Only prompt once** check box.
- **Fixed** — saves the output files to a specific folder every time. Use the **Browse** button to select the destination.
- **Relative** — saves the output files in the folder specified in the text box relative to the folder that contains the master files that you are exporting. For example, entering "Converted" in the text box would tell this batch to create a subfolder called "Converted" in each of the folders where the original master files are stored. The output files are saved within the "Converted" folders.
Image Type settings

Image Type lets you choose a file format type. If you choose JPEG, you can set a value in the Quality box.

Output Name and Location settings

This section controls how Corel AfterShot Pro names the files that you're outputting.

You can choose a preset renaming format from the drop-down list, or you can type the formatting codes in the box below the drop-down list. For more information about renaming formats, see Renaming formats.

Save in subfolder lets you specify a subfolder so that images from different output tabs in the same batch are output to different folders. For example, you can create thumbnails on one tab and save them in a subfolder named "thumbs" and save full size JPEG images into a separate folder using a single batch. This folder is specified relative to the overall batch destination.

Overwrite existing output files — replaces existing files that have the same name with those being created with the latest batch.
**Ask for job name each time** — if you use the *[jobname]* renaming variable as part of the renaming format, it ensures that you are prompted to choose a job name each time images are sent to this batch. If this option is not checked, the last job name for the batch is used.

**Image Sizing settings**

This section allows you to alter the size of your output images and choose scaling quality.

- **Normal / Proof** — select the quality for scaling the image. **Proof Quality** produces images that are half-height and half-width of the original image.
- **Do Not Resize** — maintains the same pixel dimensions as the original image file.
- **Resize Width/Height** — resizes the output image to fit within the specified dimensions. Enter a maximum pixel **Width** and pixel **Height** in the boxes to the right.
- **Resize Long/Short** — resizes the output image to fit within the specified dimensions. Enter a maximum value in pixels for the long and short edge of the output image in the boxes to the right. **Long/Short** resizing lets you specify a non-square bounding box that the output image will be fit into, regardless of the landscape/portrait formatting of the image.
• **Do not enlarge** — similar to **Resize to Fit** except that small images will not be expanded to fit the specified dimensions.

**Note:** For more information about resizing, see *About image size*.

**Additional Image Settings**

This section lets you apply presets or metadata to your images before creating output images. Multiple presets can be added to a single batch. The presets are applied in the order in which they appear. You can drag presets to reorder them in the list.

![Additional Image Settings](image)

**Add Preset** button — lets you to add a preset to apply to your output images.

**Remove Selected Preset** button — lets you remove a preset.

**Output Color Space** — lets you convert the color space. Note that this can affect the color, contrast, and overall look of your output images, so we recommend that you soft proof to preview the effect on specific images.
Metadata settings
This section provides control over the metadata included in the files that you are outputting. You can also set the DPI.

Embed EXIF — writes EXIF data to the output file, including shutter speed, aperture, and other shooting data.

Embed XMP — writes metadata to the output file in both XMP/IPTC format as well as legacy IPTC formats.

Embed color profile — includes the color profile in the output file.

Embed Copyright — includes copyright information regardless of the EXIF or XMP embedding options.

DPI — lets you enter a DPI value for the files. This does not affect the pixel size or file size of the resulting image. For more information about resizing, see About image size.

Post Processing settings
This section lets you perform additional adjustments after each image has been converted.
Output Sharpening — applies additional sharpening to images. Output sharpening is a standard USM process or unsharp mask sharpening.

Open in application — lets you launch an external application at the end of the output process.

Web Galleries

Corel AfterShot Pro helps you share your images with Web galleries. Some of the settings on the Gallery tab are shared with other batch settings. For more information, see Understanding settings for batches.

The Gallery Settings area includes the following settings:

- Gallery Type — lets you choose a layout.
- Gallery Heading — sets the label at the top of each gallery webpage.
• **Gallery Title** — set the gallery title in the title bar of the Web browser.

• **Display Metadata** — lets you choose the metadata set that you want to include on the details page for each image.

• **Thumbnail image size** — sets the height and width for thumbnail images.

• **Preview image size** — sets the height and width for preview images.

---

**Using batches to copy files**

You can use the **Copy** settings in the **Batch Output Settings** dialog box to make copies of the master files and associated sidecar files. You can save the files to the destination of your choice.

**Why use a batch to copy files?** You can do any of the following:

- transfer photos from a memory card or other storage device
- archive
- back up files

You can also choose to import at the same time as you copy, saving you a step.

When you copy with a batch, all the master files that you select are copied as well as the sidecar files that contain data about any versions, edits, and metadata.

Some of settings for copying are the same as other batch settings. For more information, see **Understanding settings for batches**. The following settings are only in the page for the **Copy** tab.

**Output Name and Location** — same as the controls described in **Output Name and Location settings**, with the addition of:

• **Delete Original files** — deletes the image that you are copying after it has been copied successfully to the new location. All
image files and associated sidecar files are copied to the location specified in the **Destination** section at the top of the dialog box.

**Import into Catalog** — enable this check box to import the images into a Corel AfterShot Pro catalog after the images are copied. The following importing options are available:

- **Import Location** — choose a catalog location
- **Prompt** — enable the check box if you want to see a dialog that asks for a catalog location when you first send images to this batch. It imports all images to the location you choose.

- **Select a folder** button — if you did not enable **Prompt**, you can click this button to choose a folder.

- **Keywords** — lets you add keywords that will be added to all the images as you import.
- **Apply Presets** — lets you apply presets to the images as you import them. For more information about presets, see *Presets*.
Printing

Corel AfterShot Pro allows you to print one or more images to any locally attached printer or a PDF file, and allows flexible layout control.

Understanding printing in Corel AfterShot Pro

Printing in Corel AfterShot Pro is handled with print batches. Each print batch is set to a specific layout type and includes other printing options. This allows you to setup printing once and quickly access those same settings later. This makes printing multiple images quick and easy.

Double-clicking a print batch in the Print section of the Output page in the Browse panel opens the Print Settings window.
Working with print batches

Controlling print jobs and page breaks

When a print layout contains more than one image on a page, such as a contact sheet, it is important to understand when printing will begin and how to control the page breaks. These operations are controlled by the **Continuous Printing** check box on the **Print Settings** panel.

**Continuous Printing On**

When **Continuous Printing** is enabled, Corel AfterShot Pro begins to process a print job as soon as enough images have been added to the print batch to fill a single page. As additional images are added to the batch, more pages are processed and sent to the printer (as pages fill up). If the page layout contains only one image, the images are sent to the printer immediately. If the print layout has multiple images on a single page, then the last page may not be auto-sent to the printer — it waits for the page to be filled. In order to print a partial page, you must open the **Print Settings** window and click **Print** in the lower right corner.

In **Continuous Printing** mode, to avoid wasting paper and ink, it is important to configure and confirm the following settings: **Printer**, **Page Settings**, **Additional Image Settings**, **DPI**, and **Layout**. This mode allows you to process a continuous stream of images as soon as they are added to a print batch. This is very useful for high-volume printing situations.

**Continuous Printing Off**

When **Continuous Printing** is not enabled, Corel AfterShot Pro queues all the images you send to the batch and does begin printing until you open the **Print Settings** window and click **Print** in the lower-right corner. This allows you to slowly choose all the images you want to
print, review the pages to be printed, remove images or add additional images until you are satisfied with the image selection and print layout. When you are ready to send the images to the printer, click **Print** in the lower-right corner of the **Print Settings** window. This opens a dialog box with **Printer Settings** specific to the selected printer. This is where you set options like paper type, print quality, and printer color management options.

When you click **Print** and accept the settings in the **Printer Driver** window, all the images that are listed in the **Print Settings** window are processed and printed, including partial pages. If you add more images to the print batch, the new images do no print automatically; they remain queued until you click **Print** again.

This mode allows you to process batches of images together and includes a page break at the end of each batch with more than one image on a page.

**Printing images**

**To send versions to a printing batch**

1. Select one or more thumbnails in the **Thumbnail panel**
2. Click the **Output** tab and do one of the following:

   - Drag the thumbnails to a batch name in the **Printing** section.
   - Double-click a batch name in the **Printing** section, set the options you want in **Print Settings** dialog box, and then drag the selected thumbnails to the dialog box.

   - If there is a shortcut key assigned to the batch you want to use (if set, shortcut keys appear to the left of the batch name), press the shortcut key.
Printing a folder of images

You can also print all the images in a folder that you select in the Browse panel (from the File System or Library).

To send a folder of images to a printing batch

1. In the Browse panel, right-click the folder you want to batch.
2. Select Send to print from the context menu, then select the name of the batch you want to use.
Managing print batches

You can create new printing batches, duplicate a print batch, and delete a printing batch. You can also rename a print batch. Sometimes it is easier to duplicate an existing batch, and make modifications to this new copy, instead of making a new batch from scratch.

You can also assign a shortcut key to a printing batch. For example, P can be assigned to the 5x7 Qty. 2 batch, so at any time, you can simply press P to add the currently selected images to the 5x7 Qty. 2 printing batch in order to print the images quickly.
To create a new print batch
1. Click the **Output** tab.
2. Right-click a blank area of the **Printing** section, and choose **New** from the context menu.
3. In the **Print Settings** dialog box, choose the settings that you want to use for the batch.

   After you create the batch, it appears in the **Printing** section list and the **Send selected files to print** context menu. You can rename the batch in the **Printing** section list.

To duplicate a print batch
1. Click the **Output** tab.
2. In the **Printing** section, right-click a batch name and choose **Duplicate** from the context menu.

To delete a print batch
1. Click the **Output** tab.
2. In the **Printing** section, right-click a batch name and choose **Delete** from the context menu.
To rename a print batch

1. Click the Output tab.
2. Right-click a name in the Printing section, and choose Rename from the context menu.
3. Type a new name for the print batch.

   **Tip:** You can also double-click (slowly) a batch name in the Printing section, type a new name, and press Enter when finished.

To assign a shortcut key to a batch

1. Click the Output tab.
2. Right-click a batch name in the Printing section, and choose Set shortcut from the context menu.
3. Press the key or key combination that you want to use for a shortcut. The shortcut appears in the Set shortcut dialog box.

Print settings

Corel AfterShot Pro comes with several pre-defined print batches designed with several different layout options. You can edit or adjust these any way you want and you can create your own print batches.

Common Print Settings

Print batches in Corel AfterShot Pro share some controls, shown below.
- **Continuous Printing** — With this check box enabled, Corel AfterShot Pro will send each page to the printer as soon as enough images have been added to the batch to fill at least one page. This is only offered on Corel AfterShot Pro.

- **Page Settings** — lets you choose your paper size, layout, and margins.

- **Printer Selection** — sets the printer to use for this print batch.

- **Output DPI** — specifies the DPI to use when sending images to the printer. A setting of 300 will produce high quality images, but some printers might benefit from settings as high as 600. Larger DPI will take longer to print, while smaller DPI will be faster, and will produce smaller files (if you are printing to a PDF).

- **Print to File** — enable if you want to bypass your printer and print to a PDF file instead. Use the "..." box to specify a file name.
## Index

### A
- About Corel AfterShot Pro 9, 16
  - Browser Panel 14
  - Catalogs 18
  - Preview Panel 15
  - Supported RAW formats 20
  - Thumbnail Panel 14
- Adjustment Presets 69
- Adjustment Tools 32
- Asset Management 9, 18, 21, 75
  - Copying Versions 26
  - Delete Versions 28
  - Managing Catalogs 25
  - Metadata Indicators 82
  - Moving Versions 26
  - Stacks 79
  - Thumbnail Indicators 82
- AutoLevel 35

### B
- Basic Adjustments 35
  - Creating Presets 40
- Basic Noise Ninja 39
- Batch Conversion 97, 99, 101
  - File Copy Batch 111
  - Web Gallery Output 110
- Batch Image Settings 108

### C
- Catalogs 21
- Cloning 64
- Color Correction 42
- Color Labels 85
- Contrast 38
- Converting Image Type 106
- Copy Image Settings 73
- Copy Master Files 111
- Create a Stack 80
- Creating Output Images 97
- Creating Versions 77
- Cropping Images 67
- Curves 40

### D
- Delete a Batch 103, 118
- Delete Versions 78

### E
- Editing Images 31
  - Adjustment Presets 69
  - Adjustment Tools 32
  - Apply Presets 70
  - Basic Image Adjustments 35
  - Copy & Paste Settings 73
  - Manage Presets 71
- Editing Regions 62
- Empty a Batch 101
- Event Printing 114
Exposure 37
External Editor 74

F

File System Mode
  About File System Mode 29
Fill Light 37

G

Grouping Versions 79

H

Heal 64
Highlight Recovery 37
Hue 38

I

Image Adjustment Tools 32
Image Adjustments 31
  AutoLevel 35
  Color Correction 42
  Color Management Mode 46
  Color Space 46
  Contrast 38
Crop 67
Curves 40
Exposure 37
Fill Light 37
Highlight Recovery 37
Histogram 35
Hue 38
Invert 51
Keywords 39
Lens Correction 50
Levels 40
Noise Ninja 39
Noise Ninja Registered 48
Perfectly Clear 36
Saturation 37
Selective Adjustments 56
Selective Color Correction 42
Sharpening 38, 47
Straighten 37, 68
Vibrance 38
White Balance 36, 45
Working Color Space 46

Image Settings 31
Importing Images 23
IPTC 91

K

Keyword Manager 87
Keyword Sets 87
Keywords 75, 87, 91

L

Labels 85
Layers 56
Lens Correction 50
Levels 40
Library 18
  Browse Refinement 96
  Browse with Metadata 94
Library 18
  Catalogs 21
  Importing Images 23
  Managing Catalogs 25
  Searching for Images 94
Linear Color Space 46

M
  Merge Stacks 81
  Metadata 75
    Color Labels 85
    Editing Metadata 91
    Flags 86
    Labeling Images 85
    Metadata Sets Manager 91
    Rating Images 86
    Reject 86
    Tagging Versions 86
    Viewing Metadata 91
Metadata Browser 94
Metadata Presets 69
Metadata Refinement 96
Metadata Sets 91

N
  New Batch Conversion 102, 118
  New Versions 77
  Noise Ninja 39
  Noise Ninja Registered 48

O
  Optional Asset Management 18
  Output Image Type 106
  Output Image 98
  Output Images 97
  Output Metadata 109

P
  Paste Image Settings 73
  Pause a Batch 101
  Perfectly Clear 36
  Plugins
    About Plugins 54
    Installing Plugins 54
  Presets 40, 69
    Creating Presets 40
    Manage Presets 71
    Using Presets 70
  Printing 113
    Add Version to Print Batch 115
    Common Print Settings 119
    Continuous Printing 114
    Managing Print Batches 117
    Standard Printing 114
    Working with Batches 114

R
  Rating Images 86
  RAW file support 20
  Refine 96
Regions 56
Reject Versions 86
Remove Version from Stack 81
Rename a Batch 103
Rename Output Image 106
Resizing Output Images 107
Resume a Batch 101

S
Saturation 37
Save As 98
Search Box 94
Selective Color Correction 42

Selective Image Adjustments
Creating Regions 56
Creating Layers 56
Editing Regions 62
Heal and Clone 64
Region Blending Modes 64
Send to Printer 115
Shared XMP Data 16
Sharpening 38, 47
Shortcut Keys, for batches 103
Sorting Stacks 81
Sorting Versions 83
Custom Sorting 83

Stacks 79
Add to a Stack 80
Merge Stacks 81
New Stack 80
Remove Version from Stack 81
Sort 81
Straightening Images 68
T
Tag Versions 86
Thumbnail Indicators 82

Versions
Copy 26, 77, 78
Delete Versions 78
Move 26, 77, 78
New 77
Vibrance 38

W
Web Gallery Output 110
White Balance 36, 45
Working Color Space 46

X
XMP 16